
H Series Robot Welding Process System

User Manual
V2.0

Guangzhou Auctech Automation Technology Ltd



Welding Process System Instruction Manual

Foreword

This series of instructions introduces the characteristics, system composition, system

commands of each part and its use, operation steps, user programming methods and examples, etc.,

which is the basic instruction manual for users to quickly learn and use the teaching pendant. The

update and upgrade of the manual are authorized and implemented by Guangzhou Auctech

Automation Technology Ltd. Without the company's authorization or written permission, any unit

or individual has no right to modify or correct the content of this manual, and the company is

not responsible for this. Customer loss.

In the instruction manual of the programming of the teaching device (Hspad), we will try our

best to describe various events related to the operation of the teaching device. Due to space

limitations and product development positioning, it is impossible and impossible for all of the

teaching device not to do or Events that cannot be done are described in detail. Therefore, events

that are not specifically described in this specification can be considered as" impossible"or" not

allowed"events.

We have checked the content of the printed matter for consistency with the described

hardware and software content, and we do not rule out inconsistencies, but we regularly proofread

the printed matter and make necessary changes in later editions. The copyright of this manual

belongs to Guangzhou Auctech Automation Technology Ltd., any unit or individual publishing or

copying is illegal, and our company will pursue its legal responsibility.
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1 Introduction

AUCTECH type III control system is a new control system independently developed by

Guangzhou Auctech Automation Technology Ltd..

1.1Target Group

This manual is mainly aimed at users who use AUCTECH industrial robots, and requires

users to have basic knowledge of industrial robots.

1.2 Icon Description

Information: provide more information for operation.

Warning: warn about potential loss that may occur.

Danger: inform the potential danger.

1.3 Terms

TCP: Tool Center Point
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2 Upgrade procedure ofwelding process system

2.1 Upgrade though Teaching Device

1. Copy the files for upgrade to a USB flash disk, and plug it into the teaching device.

Enter the ES explorer, select U-disk after clicking the quick navigation button in upper-left corner

to enter the US flash disk, and then click to install the software named HSPad 3-1.6.3XXXXXX-

WELD.APK in the upgrade folder"Teaching Device"(as illustrated in Figure 2-1).

Figure 2-1 Install HSPad software

2.Open the HSPad software after its successful installation; enter into the interface of

Process package management through finding in sequence Configuration- Teach Pendant

Configuration- Process package management in the navigator, and click Install Craft package in

the lower corner (as illustrated in Figure 2-2), that is when a dialog box pops up from which

enter into the folder"Teaching Device”, select HS3_VX.X.X.XXXXXX_HJ.apk (as illustrated

in Figure 2-3), click"Sure"and wait for completion of installation. Restarting as notified after

installation is completed means successful installation of HSPad.

Figure 2-2 Install craft package
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Figuare 2-3 Install craft package

3.On the premise of successful installation of HSPad, enter the software and click buttons in

sequence"Menu”-“System”-“Cleaning system"(as illustrated in Figure 2-4) , and then click Sure

when a dialog box that says"Are you sure about cleaning the system?"arises. Cleaning the system

will release controller’s storage space from pre-occupied junks (including remaining upgrade

package files, system backup files, etc. Hence it is necessary to clean the system).

Figuare 2-4 Clean the system

4.This step shall only be executed when the system is to upgrade from the versions of 2.0.2,

2.0.3 or 2. 1.0 to version 2.2.0, while step 5 shall be executed if it is the first time for the system

to be upgraded or to upgrade directly from version 2.0. 1 to 2.2.0.

After plugging the USB flash disk into the teaching device, find and decompress the

compressed file named ver_HSC3-V2.2.0.XXXXXX under"System Folder"of the upgrade

package, and then copy the file Hsc3Upgrade.tar.gz into a folder without a Chinese folder name.

After that, start HSPad app and straight-forwardly click buttons"Menu”-“System”-“System

upgrade”. With the directory of USB disk displayed, select to enter the ungrade package list and

send the upgrade file named Hsc3Upgrade.tar.gz (with a suffix. tar.gz) by clicking"Send update

package"(as illustrated in Figuare 2-5). After successfully sending the upgrade file,
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click"Sure"and restart the controller after powering off (check whether the zero point is correct

or not). Then the system upgrade is completed.

Note: There shall be no file under a Chinese name in the upgrade path, or the upgrading fails.

5.This step shall only be executed when it is the first time for the system to be upgraded or

to upgrade directly from version 2.0 . 1 to 2.2 .0 , and if the system is to upgrade from the versions

of 2.0.2, 2.0.3 or 2. 1.0 to version 2.2.0, step 4 shall be executed.

With USB flash disk plugged into the teaching device, decompress ver_HSC3-lib4plugin

under folder"System"and copy the file Hsc3Upgrade.tar.gz in the decompressed folder of

Hsc3Upgrade_out to anther folder without a Chinese name. Decompress the package

ver_HSC3-V2.2.0 .XXXXXX under"System Folder"and then copy the Hsc3Upgrade. tar.gz in it

also to a folder named in language other than Chinese.

Then start HSPad, directly click buttons of"Menu”-“System”-“System upgrade”. Displaying

the directory of USB flash disk and select to enter the ungrade package list and send the upgrade

file named Hsc3Upgrade.tar.gz (with a suffix. tar.gz) under Hsc3Upgrade_out by clicking"Send

update package”. After successfully sending the upgrade file, click"Sure" and restart the

controller after powering off.

Repeat the procedure of clicking"Menu”-“System”-“System upgrade"after a successful restart.

Displaying the directory of USB flash disk, select to enter the ungrade package list and send

the file named Hsc3Upgrade.tar.gz (with a suffix . tar.gz) under folder ver_HSC3-

V2.2.0.XXXXXX by clicking" Send update package"(as illustrated in Figuare 2-5). After

successfully sending the upgrade file, click"Sure"and restart the controller after powering off

(check whether the zero point is correct or not). Then the system upgrading is completed.

Note: There shall be no file under a Chinese name in the upgrade path, or the upgrading fails

Figure 2-5 Select upgrade file
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6.If it is the first time to upgrade the system and directly to Version 2.2.0, there is n

o need to execute this step. If it is to upgrade from versions of 2.0. 1, 2.0.2, 2.0.3 and 2.

1.0 to version 2.2.0, file config under ftp://10.10.56.214/usr/codesys/hsc3_app/plugins/WeldP

ackage-1.0-SNAPSHOT/ of the controller shall be transferred to its parent directory, and th

en transfer configAUTHCODE_9 and configTOTALTIME_9 to the folder where config was copied.

The concrete steps are as follows.

When executing this step, please take photos of the data of welding channel and pendulum

channel interfaces in the process parameters of the craft package in case ofloss of process data.

Steps of entering ftp though teaching device are as follows:

(1) Click ES file explorer from the main application interface of the teaching device and

select FTP (as illustrated in Figure 2-6) under Network provided in the Fast Access.

Figure 2-5 Select FTP server

(2) After entering the interface of FTP, click to establish a new FTP server where

10.10.56.214 shall be filled in following Server, root after Username and 111111 after Password,

and thereafter click"OK”, as illustrated in Figure 2-7.

Figure 2-7 Establish a new FTP server

(3) If you upgrade from 2.0. 1, 2.0.2, 2.0.3 and 2. 1.0 to 2.3.0, click 10.10.56.214/usr/c

odesys/hsc3_ In the app / plugins / weldpackage-1.0-snapshot / directory, set config and a uthcode_

9. configTOTALTIME_ 9. Select the file and click the copy button (as shown in Figure 2-8). After
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copying, return to the upper level directory (i.e. 10.10.56.214 / usr / C oDeSys / hsc3)_ Click the

paste button under app / plugins / (as shown in Figure 2-9). A fter copying, long press

wavechannel.xml and weldchannel.xml in config and click the del

ete button (as shown in Figure 2-10). After deletion, restart the controller to complete the upgrade.

Note: please take photos to back up the channel data before deleting

Figure 2-8 Copy the files

Figure 2-9 Paste the files
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Figure 2-10 Delete the files

(4) When upgrading from version 2.2.0 to version 2.3.0, you need to delete the modfconfig.xml
file in the config folder, and restart the controller after deletion (as shown in Figure 2-11).

Figure 2-11 files to be deleted when upgrading from version 2.2.0 to version 2.3.0

(5) When upgrading from version 2.3.0 to version 2.4.0, you need to delete the

wavechannel.xml file in the config folder, and restart the controller after deletion (as shown

in Figure 2-12).

Note: please take photos to back up the channel data before deleting.
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Figure 2-12 files to be deleted when upgrading from version 2.3.0 to version 2.4.0

（6 ）When upgrading from version 2.4.0 to version 2.4.1, you need to change the

weldchannel in the config folder Delete the XML file (as shown in Figure 2-13) and change

systemconfig The < item5 arcchannelnumber < / item5 > parameter in the XML file is changed

to 30 (as shown in Figure 2-14). Restart the controller after operation.

Note: please take photos to back up the welding channel data before deleting.

Figure 2-13 files to be deleted when upgrading from version 2.4.0 to version 2.4. 1
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Figure 2-14 files to be changed when upgrading from version 2.4.0 to version 2.4.1

(7) Upgrade from version 2.4. 1 to version 2.4.2 normally.

Note: Before upgrading from version 2.4.2 to version 2.4. 1, you need to back up the

calibration data in System - Import export Calibration Parameters before upgrading. After

upgrading, you need to re select the model, and then import the previously backed up calibration

data.

Fig. 2-15 Import and export calibration parameters

（8）Upgrading from any previous version to version 2.4.3 requires switching the model

once.

（9) 1.6.9 Upgrading 1.6.11 The system can start normally only after the driver firmware is

upgraded
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2.2 Upgrading through CA
1.Copy the upgrade file to the USB flash drive, insert the USB flash drive into the teacher, enter

the ES browser, select udisk from the shortcut navigation on the upper left corner to enter the USB
flash drive, and click the HSPad3-1.6.6XXXXXX-W ELD.APK software installed in the upgrade
folder (as shown in Figure 2-16).

Figure 2-16 Installing an HSPad

2. After HSPad is installed, open the HSPad software, find Configuration-Demon strator
Configuration-Process package management in the navigation to enter the p rocess package
management interface, click the Install process package button in th e lower right corner (as shown
in Figure 2-17), and find the"Demonstrator"folder in the pop-up dialog box. Select
HS3_VX.X.X.XXXXXX_HJ.apk (as shown in Figure 2-1 8), click OK, and wait until the
installation is complete. After the installation is com plete, restart HSPad as prompted.

Figure 2-17 Installing a process package
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Figure 2-18 Installing a process package

3. Connect the controller network cable to the PC, open ControlAssistant_win.exe

software, click Add in the lower left corner, and enter IP address 10.10.56.214 and port
number 23234 in the displayed Configure Controller dialog box, and click OK (as shown in Figure
2-19).

Figure 2-19 Connecting a controller

4.Select the newly created controller and click Connect (as shown in Figure 2-20). If the status is
displayed as Ready, the controller is successfully connected.
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Figure 2-20 Connecting the controller

5.After the connection is successful, switch to the command screen, enter lib.clearDisk() , and
press Enter to clear the system, as shown in Figure 2-21.

Figure 2-21 Cleaning system instructions

6.Perform this step if the system is upgraded from 2.0.2, 2.0.3, 2.1.0, or 2.2.0 to 2.3.0. Do not
perform this step if the system is upgraded from 2.3 .0 for the first time or from

2.0.1 to 2.3.0.

Decompress the ver_HSC3-V2.3.0.XXXXXX file in the System folder, right-click the newly

created controller on the controller monitoring page, and select Upgrade from the displayed list

(as shown in Figure 2-21). The upgrade dialog box is displayed. gz (the extension of the upgrade

package is.tar.gz) in the upgrade package (as shown in Figure 2-21), click the upgrade button,

and restart the controller after the restart is complete.

Note: The upgrade path cannot contain a Chinese file name. If a Chinese file name is
included, the upgrade will fail.

7. Perform this step if the system is upgraded to version 2.3.0 for the first time or from version
2.0.1 to version 2.3.0. Perform Step 6 if the system is upgraded from version 2.0.2, 2.0.3, 2.1.0,
or 2.2.0 to version 2.3.0.

Decompress the ver_HSC3-V2.2.0.XXXXXX file and the ver_HSC3-lib4plugin file in the
System folder, and copy the decompressed file to a directory without a Chinese file name.

Right-click the newly created controller on the controller monitoring screen. In the
displayed list, select Upgrade (as shown in Figure 2-21). The upgrade dialog box is displayed.
Select the hSC3Upplant.tar. gz upgrade file in the ver_HSC3-lib4plugin folder. Then click the
Upgrade button, wait for the restart controller time to complete, restart the controller.
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After the controller is restarted, right-click the newly created controller on the

controller monitoring page, and select Upgrade from the displayed list, as shown in Figure 2-21.
The upgrade dialog box is displayed. Select the upgrade file Hsc3Upgrade.tar.gz (the extension of
the upgrade package is.tar.gz) in the ver_HSC3-v2.0. XXXXXX folder (as shown in Figure 2-22),
and click the upgrade button. After the controller is restarted, restart the controller.

Note: The upgrade path cannot contain a Chinese file name. If a Chinese file name
is included, the upgrade will

.

Figure 2-22 Upgrading the system

Figure 2-23 Selecting the upgrade system file

8.If the system is upgraded to version 2.3.0 for the first time, you do not need to

perform this step. If from 2.0.1, 2.0.2, 2.0.3, 2.1.0 version 2.2.0 version upgrade to 2.3.0

word, still need to the controller in the ftp://10.10.56.214/usr/codesys/hsc3_app/plugins/
directory for file operations, specific steps are as follows:

Before performing this step, you need to take pictures of the welding channel, swing
welding channel, and curve configuration interface data of the welding machine in the
process parameters of the process package to avoid process data loss.

The steps to enter ftp are as follows:
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(1) In the Computer text box, enter ftp://10.10.56.214, and press Enter to connect to the
controller directory, as shown in Figure 2-24.

Figure 2-24 Connecting to the FTP server

(2) After obtaining the access permission, go to the controller file directory, right-click the

blank area, choose Log In, and enter the user name and password to log in to the controller

directory, as shown in Figure 2-25.
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Figure 2-25 Logging in to the FTP server

(3) ftp://10.10.56.214/usr/codesys/hsc3_app/plugins/WeldPackage-1.0-SNAPSHOT/ will

config, configAUTHCODE_9, configTOTALTIME_9 in the directory File (as shown in figu re 2-

26) is copied to the directory at the next higher level (i.e. 10.10.56.214 / usr/codesys

hsc3_app/plugins /), xml and WELDCHANNEL.xml files (as shown in Figure 2-27) in th e

config folder are deleted. After the files are deleted, restart the controller to complete th e upgrade.

Note: Take a photo to back up channel data before deleting

it.

Figure 2-26 Copying a
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file
Figure 2-27 Deleting files

(4) When upgrading from 2.2.0 to 2.3.0, delete the modfCONFIG.xml file in the config folder,
and then restart the controller, as shown in Figure 2-28.

Figure 2-28 Deleting files before upgrading from 2.2.0 to 2.3.0

（5）When upgrading from 2.3.0 to 2.4.0, delete the WAVECHANNE.xml file in the config
folder and restart the controller, as shown in Figure 2-29.

Note: Take a photo to back up channel data before deleting

Figure 2-29 Files to be deleted when 2.3.0 is upgraded to 2.4.0
（ 6） When upgrading from 2.4.0 to 2.4.1, delete the WELDCHANNE.xml file in the

config folder, as shown in Figure 2-30. Change the <item5 arcChannelNumber </item5 >

parameter in the SYSTEMCONFIG.xml file to 30, as shown in Figure 2-31. Restart the controller

after the operation.
Note: Take a photo to back up the welding channel data before deleting it.
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Figure 2-30 Deleting files before upgrading from 2.4.0 to 2.4.1

Figure 2-31 Files required for upgrading from 2.4.0 to 2.4.1
(7) Upgrade from 2.4.1 to 2.4.2.

Note: Before upgrading from 2.4.2 to 2.4.1, you need to back up calibration data in System
-Import/Export calibration parameters. After upgrading, you need to re-select the model and then
import the previously backed up calibration data

.

Figure 2-32 Importing and exporting calibration parameters

（8 ）When upgrading from any previous version to version 2.4.3, you need to switch models

once.
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3 Brief introduction of AUCTECH Ⅲ control system

AUCTECH III industrial robot control system is a control system independently developed

by AUCTECH Robotics Co., Ltd. It has the characteristics of high speed and high precision, and

its programming language is simple and easy to understand. Adjustment to meet the vast majority

of industrial needs.

3.1 System composition

The composition of the AUCTECH industrial robot system mainly includes the following

four parts:

l Mechanical arm
l connecting cable
l Electronic control system
l HPad teach pendant

Figure 3 - 1 Connection diagram of HPad and AUCTECH robot

3.2 AUCTECHⅢTeaching Pendant Software

AUCTECH III control system mainly includes

l AUCTECH Robot Teaching Pendant Software HSC3- HSPad
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4 Safety

4.1 Notes

1. AUCTECH robot users must operate the robot under the condition of ensuring their
own safety.

2. Ensure that the state of the robot is stable and the base is stable.

3. Users of AUCTECH Robot must operate the robot in accordance with the regulations,
and illegal operations are strictly prohibited.

4. Before using the AUCTECH robot, make sure that the surrounding environment will not
affect the robot.

5. Guangzhou Auctech Automation Technology Ltd. is not responsible for the safety of the
robot.

6. Guangzhou Auctech Automation Technology Ltd. reminds users that safety equipment
must be used when using AUCTECH industrial robots, and safety provisions must be
followed.

7. The AUCTECH robot can move a large distance at a high speed.

the AUCTECH robot is powered off, it needs to wait for the

discharge to complete before powering on again.

8. Never turn your back to a robot.

4.2 When the robot cannot be used

1. Combustion environment.

2. A potentially explosive environment.

3. An environment with radio interference.

4. In water or other liquids.

5. Moving people or other animals.

6. Not clinging.

7. Other occasions that cannot be used.

4.3 Safe operating procedures

4.3.1 Teaching and teaching the robot
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1. Try to use a lower speed override when jogging the robot.

2. Consider the movement trend of the robot before pressing the jog button on the software.

3. Consider the movement trajectory of the avoidance robot in advance, and confirm that the
route is not disturbed.

4. The area around the robot must be clean, free of oil, water and impurities.

4.3.2 Production Movement

1. Before starting the operation, you must know all the tasks that the robot will perform
according to the programmed program.

2. The position and status of all switches, sensors and control signals that affect the
movement of the robot must be known.

3. The location of the emergency stop buttons on the robot controller and peripheral control
equipment must be known and prepared to use these buttons in an emergency.

4. Always keep a safe distance from the robot.
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5 AUCTECHⅢ Teaching Pendant

5.1 Front

Figure 5- 1 Front of Hspad

label item illustrate

1

Key switch for recalling the connected controller. The state can

only be transitioned after the key is inserted.

The operating mode ( Teach /Auto/External) can be switched by
connecting the controller.

2
Emergency stop button (emergency stop). Used to stop the
robot in dangerous situations.

3 Jog the run key. Used to teach mobile robots.

4
Button for setting the program adjustment amount. Automatic,
external operation override adjustment.

5
Button for setting the teaching adjustment amount. Automatic
run rate adjustment.

6
menu button. Switching between menu and file navigator is
possible.

7 Pause button. When running the program, pause the operation.
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8
stop key. Use the stop key to stop and uninstall running
programs.

9 Back button. Use the back button to back out the program.

10
Start running key. When the program is loaded successfully,
click this button to start the program.

11 Alternate button.

5.2 Back

Figure 5- 2 Hspad back

label item illustrate

1

Three-stage safety switch.
The safety switch has 3 positions:
①Not pressed
②Middle position
③ Press down fullyteaching mode of the running mode, the
confirmation switch must be kept in the middle position so that the
robot can move, and the other positions are turned off.
In automatic operation mode, the safety switch has no effect.

2 The HSPad label model is pasted.

3 Debug interface.

4
USB flash drive.
The USB interface is used for operations such as archive/restore.
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5.3 HSPad operation interface

Figure 5- 3 Operation interface

label item illustrate

1

Information prompt counter.

The message prompt counter shows how many messages of each
message type are waiting to be processed. Touch the information tip
counter to enlarge the display.
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2

Status Bar.

the current model, load level, loaded program, enable status,

program status, running mode, override, program running mode,

tool workpiece number, and incremental mode.

3

Information window.

By default only the last information tip will be displayed. Touch the

info window to display a list of info. All pending messages are

displayed in the list.

The information that can be confirmed can be confirmed with the

【Confirm】key.

【Message Confirmation 】key to confirm all information except

error information.

【Alarm Confirmation】key to confirm all error messages.

The"?"key can display the details of the current message.

4

Coordinate system state.

Touch this icon to display all coordinate systems, and select and
switch.

5

Welding function and jog running instruction.

If it is not enabled, it is the welding function icon. The welding
function can be turned on and off, and the icon will turn green
after it is turned on.

If the axis-related operation is selected after enabling, the axis

number (A1, A2, etc.) will be displayed here. If Cartesian run is

selected, the orientation of the coordinate system (X, Y, Z, A, B, C)

will be displayed here.

Touching the icon displays the kinematics group selection

window. When a group is selected, it will be displayed as the

corresponding name in the corresponding group.

6
Flip the program line up and down, and use it after loading the
program.

7 Zoom adjustment icon.

8 External pause point function icon.

9
Action menu bar.

For program file related operations.

10 network status.
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Red is the network connection error, check the network line

problem.

Yellow means that the network connection is successful, but the

initialization of the controller is not completed, and the robot

cannot be controlled.

Green indicates that the network is initialized successfully, and the

HSPad is normally connected to the controller, which can control

the movement of the robot.

11 Robot stop and motion indication icon.

12 The current user icon, click to enter the user login interface.

1 3

clock.

The clock displays the system time. Clicking on the clock icon will

digitally display the system time and the current operating time of

the system.

5.3.1 Status bar

The status bar shows the status of the industrial robot settings. In most cases clicking on the
icon will open a window where you can change the settings.

Figure 5- 4 Status Bar

label item illustrate

1 menu.
The function is the same as that of the menu button.

2 Robot name.
Displays the current robot model and load level.

3
Loader name.
After loading the program, the path and name of the currently loaded

program will be displayed

4

enable state.
Green and displays"On", indicating that the current enable is on.
Red and displays"off", indicating that the current enable is off.
Click to open the enable setting window. In automatic mode, you can
only set the enable switch state by clicking on/off on the interface.
The pressed state of the safety switch can be displayed in the
window.
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teach mode, it can only be turned on or off by the safety switch

5
Program running status.
When running automatically, the running status of the current program is
displayed.

6
Mode status display.
The mode can be set by the key switch, and the mode can be set to
teach mode, automatic mode, external mode.

7

The magnification adjustment is displayed.
When switching modes, the override value of the current mode will

be displayed.
Touching will open the setting window, you can use the plus/minus (+
/- ) keys to add or subtract in units of 1%, or drag the scroll bar to the
left or right.

8

Program run mode status.
In automatic operation mode, it can only be continuous operation,
and in teaching mode, it can be set to single-step or continuous
operation.
Touching will open the setting window, and in teaching mode, you
can click the continuous/single step button to switch the operation
mode.

9

Activate base coordinates/tool display.
Touch will open the window, click the tool and base coordinate to
select the corresponding tool and workpiece to set, the available tool
workpiece number is 0 ~ 15.

10
Load display
Touch to open the dynamic plug in the number selection, click the
corresponding load number to switch.

11

Incremental mode display.
in teach mode, click the corresponding option to set incremental
mode.
Sustainability : Sustained movement
Non-continuous: move according to the set incremental distance
(joint or space mm inching)

5.3.2 Main menu

Steps
Click the"main menu icon"or key to open the main menu of the window.

Click the"Main Menu Icon"or button again to close the main menu.

Describe
the main menu window properties:
The main menu is displayed in the left column.

。
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Clicking on a menu item will display the sub-menu to which it belongs (eg: Configuration).

When you click to open a large number of sub-menu layers, you may not see the main menu
bar, but only the menu. At this time, the latest three-level menu display will be displayed.
The upper left"Home icon"key closes all open sub-menus and displays only the main menu.
In the [lower area], the last selected menu item (up to 6) will be displayed, which is equivalent
to a shortcut menu. This allows the menu items to be selected again directly without first
closing the open submenus.
The red cross ("X") on the left closes the window.

Figure 5- 5 Main menu interface
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6 User permission function

illustrate

There are 3 user groups in the current version, namely production staff, engineers, and

manufacturer staff. The specific user permissions are as follows. (Note:" ×"does not have

permission to display this interface, viewing means that you can only enter this page but

cannot use this function,"√"means editable/useable), in the HSpad system software, different

users have different permissions.

There are the following user groups:

Producer User :

Production personnel user group, this user group is the default user group, which can

only produce and simple trajectory motion.

Engineer users :

Engineer user group, this user group has more rights to use system functions than the

default ordinary user. Can change welding parameters, edit and change programs, etc.

After the user logs in, select"Keep Engineer User"to restart as an engineer user. After selecting

this, log in to the producer and manufacturer personnel and restart to restore the default as the

producer user. This user is protected by a password.

Manufacturers and users :

user group with the highest authority, after logging in to this user, the next restart will be

the production user user. This user has all the right to use the H spad system. This user is

protected by a password.

[Remarks] The default password of the engineer user is"hspad".

A menu Secondary
menu

Tertiary

menu

User group permissions

Producer Engineer Manufacturer
personnel

file
Management

Backup
restore
settings ——

You can
only

choose to
set it as the

root
directory of

the U
disk/default

You can
only

choose to
set it as the

root
directory of

the U
disk/default

√
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path, and

you cannot

edit the

custom

path

path, and

you cannot

edit the

custom

path

Lock

password

settings

——
×

× √

get register

file
——

Can only

get but not

send

√ √

log file

manageme

nt

—— √ √ √

PRG

program

file

operation

new —— × √ √

Open —— √ √ √

Program

starts

editing

—— × √ √

delete —— × √ √

backup —— √ √ √

recover —— × √ √

Multiple

choice
——

×
√ √

Rename —— × √ √

locking —— × √ √

On/Off

Instructions
—— × √ √

On/Off

state
—— × √ √

release

waiting
—— × √ √

configure

Teach

Pendant

Configuratio
n

user group √ √ √

Alternate

button
Check √ √
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configuration

Process
package

management Check Check √

Controller
Configuration

Robot
Communic-

ation
Configuration Check Check √

Axes group
Configuration Check Check √

Collaborati-
on group

Configuration Check Check √

Robot
parameters Check Check √

external
run

Configuration Check √ √

Encode/De-
code

Configuration Check Check √

Regional
Configuration Check Check √

Modbus
Configuratio-

n × × √

Modbus × × √
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mapping

timeout

setting
Check Check √

Authorize Check Check √

show

input/output

digital

input/output Check √ √

Analog

input/output Check √ √

actual

location
—— Check Check Check

Variable

list JR, LR,

R

—— Check √ √

Variable

List Tool

Artifact

—— Check Check √

Modbus

display
—— × × √

diagnosis run log
show √ √ √

configure Check √ √

put into

service

Measureme-
nt

User tool

calibration
Check √ √

User

workpiece

calibration

× × √

Collaborati-

ve group

calibration

× × √

External

shaft

reduction

ratio

calibration

× × √
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20 point

calibration
× ×

Adjustment calibration Check Check √

Software

limit switch
—— Check Check √

help Version

Informatio

n

—— √ √ √

system
Revelation

Teaching

Tool

—— √ √ √

clean up

the system
—— √ √ √

shut down

the system
—— × √ √

reboot the

system
—— × √ √

System

Upgrade
—— × × √

Import and

export user

PLC

—— × × √

Import and

export

calibration

parameters

—— × × √

interface

button

Start/Pause

/Uninstall

buttons

—— √ √ √

Mode

switch
—— √ √ √

Teaching

mode

enabled

—— √ √ √

Auto/Exter —— √ √ √
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nal Mode

Enable

Tool

workpiece

switching

—— × √ √

Program

step/contin

uous

—— √ √ √

Teach

continuous/

inch

—— × √ √

Override —— √ √ √

Teaching

coordinate

system

replacemen

t

—— √ √ √

Program

line page

button

—— √ √ √

auxiliary

button
—— √ √ √

Collision

trigger

button

—— √ √ √

Synergy

switch
—— √ √ √

welding

switch
—— √ √ √

gas

detection

switch

—— √ √ √

Wire feed

control
—— √ √ √

Wire feed —— √ √ √
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rate

movement

to the point
—— √ √ √

jump —— √ √ √

point

record
—— × √ √

Back to

Pause

button

—— √ √ √

craft kit

Welding

process

package

System

Configu
ration

Check √ √

System

Configur
ation -

Positioner

Configu
ration

× × √

Welder

curve

parameter

Configu
ration

Check √ √

Process

parameters
Check √ √

Production

Statistics
√ √ √

Running

time

statistics

Check √ √

Authorize Check Check √

Analog

correction
× × √

Steps
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1. Select" User Login" in the main menu or click" User Icon"on the main interface. The
current user group will be displayed.

2. If you want to switch to the"producer"user, select the user group as"producer"and

press login.

3. Engineer users and manufacturer personnel users need to enter the password to log in,
and enter the password to log in to confirm.

4. The user icon on the main interface is green to represent the current production user,
yellow represents the current engineer user, and red represents the current manufacturer
user.

5. Modify password: If you need to modify a user's password, select the user and click
the"Modify Password"button.

6. After entering the original password and the new password in the password
modification interface, click the"OK"button to complete the password modification.

Figure 6-1 User login interface
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7 File functions

7.1 System parameter file management

This function sets the modification permission to the vendor user

Steps

Select Menu Bar → File → System Parameter File Management
Select Import File → Click the" Import"button to confirm the operation

Select the export directory → Click the"Export"button to confirm the operation

Figure 7-1 System parameter file management

7.2 Program data file management

This function sets the modification permission to the vendor user

State
The program data file management function is divided into two parts: obtaining
register file and sending register file (variable list register file, IO description file),

obtaining controller register file through U disk, and sending storage file to controller.
operating steps
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1. Choose > File > Program Data File Management from the menu bar.
2. Click the check box and select the file you want to import or export.

3. Click the Import File/Export File button.
4. Click"Confirm"to confirm the operation.

l Export the program data file to the selected path in the upper folder
regfile.

l Import program data files also need to be sent to the selected path
above the regfile folder. (The sending program data file takes effect after
the system restarts.)

l before delivery, the value of the corresponding program data file is 0,
and obtaining it fails.
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Figure 7-2 Gets the send register file

7.3 Import or export a user PLC

This function sets the modification permission to the vendor user

State

Import and export the user PLC function, you can back up the user PLC in the
existing controller system through the U disk, you can also import a new user PLC to
update/restore the system environment.
Export the user PLC procedure

1. Insert the USB flash drive. After the USB flash drive is successfully identified
2. Open the menu and click"System → Import and export user PLC"

3. Click the [Select Directory] button of the export module to determine the export
path

4. Click the [Export] button. After the export is successful, the corresponding file
will be found in the selected export path.

picture 7 - 3 Import or export user PLC-1

Import the user PLC procedure

1, insert the U disk, U disk identification success
2, open the menu, click"System → Import and export user PLC"

3. Click the"Select File"button of the import module (select app file) to confirm
the file to be imported

4. Click the"Select File"button of the import module (select crc file) to confirm the
file to be imported

5, click [Import] button, prompt" Import file successfully, please power off and
restart the controller!"After power failure and restart, the poured user PLC takes effect.
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picture 7 - 4 Import or export user PLC-2

The PLC cannot be imported or exported when the network
connection fails
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8 Configuration function

8.1 Teach Pendant configuration

8.1.1 Alternate key configuration

Auxiliary keys can only be used in teaching and automatic modes, and

cannot be used in external mode. The modification authority of this

function setting is the engineer user and above.

Backup

button configuration Click menu - Configuration - Teach Pendant Configuration - Backup

button configuration, as shown in Figure 8-1 Backup button configuration:

Figure 8-1 Alternate button configuration

After selecting, enter the interface shown in Figure 8-2.
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Figure 8-2 Button function selection

As shown in the figure, a total of four spare buttons can be configured, 0-3 correspond to

the four buttons from top to bottom in the lower left corner of the teach pendant. Button

configuration process :

（1） Select the corresponding row of the button to be configured, for example, to configure

the first button, select the row with serial number 0. After selection, as shown in Figure

8-3.

Figure 8-3 Key list

（2） Click Modify, and the function configuration button below becomes an optional option.

After clicking, select the process package, and the screen shown in Figure 8-4 will appear.
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Figure 8-4 Function List

As shown in the figure, you can select the configuration bit alternate key function in the

content displayed below.

(3) Select the desired function and click OK, and a prompt box will pop up as shown in

Figure 8-5, completing the configuration of the function button.

Figure 8-5 Prompt for successful configuration
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8.1.2 User group

Figure 8-6 User group page

State

To display the current login user, you can customize user registration or switch login
users.

The Final user can register a custom user (permission setting, logout, and
registration buttons are used by custom users).
operating steps
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1 . Choose Configuration > Instructor Configuration > User Group from the main menu.
2. Tap Standard to switch to the Normal user automatically.

3. Click Login. You can choose to switch the login user.

8.1.2.1 Users login
State

There are three user levels set by the system, which are production personnel,
debugging personnel and administrators. In addition, users can also register custom users in
the system. Different users have different permissions.

lProduction personnel: operator user group. This user group is the default user

group.

lDebugger: The debugger user group that has access to most system features. This
user is protected by a password.

ladministrator: user group with the ultimate permission. This user has all the
rights to use the system.

lUser-defined users: Users are allowed to use the functions of the user group. The
default user level is production member. To change the user level, perform the following
steps.
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Figure 8-7 User login interface

operating steps

1. Choose → Configuration → Instructor Configuration → User Group from the main
menu. The current user group is displayed.

2. 2. To switch to the default user group, click the [Standard] button. (If you are already
in the default user group, you cannot use standards.) To switch to another user group,
select the desired user group and click Login.

3. 3. The debugger and administrator need to enter the password to log in, enter the
password to log in and confirm.
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4. 4. Change the password: If you want to change the password of a user, select the user
and press [Password...] Button.

5. 5. On the password change screen, enter the old password and new password and
click OK

Click the"User Quick Login"icon on the operation interface to
quickly enter the user login interface.

Figure 8-8【 User Shortcut login 】 icon

8.1.2.2 User rights configuration

State
The user rights configuration function allows a user to perform different

operations based on requirements. By configuring the operations, you can reduce the
possibility of system instability caused by misoperations.
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Figure 8-9 User rights configuration
configuration flow

1. Register and log in:
Log in to the Instructor Configuration → User Group and click the"Register"button

to complete the process of registering a new user in sequence.

After the registration is complete, you can select the registered user to log in on
the login screen.

2. Customize user function permission Settings:

Log in to administrator rights

Click [Permission Configuration]. On the permission configuration screen, you
can customize the operation permissions of a user.
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8.1.3 Lock password

This function sets the modification permission to the vendor user.

State
This function changes the program lock password.

operating steps

1. Choose Configuration > Instructor Configuration > Lock Password from the main
menu.

2. Enter the old password and new password and click OK to save the new
password, as shown in Figure 8-10.

Figure 8-10 Change lock password

8.1.4 Robot communication setup

This function sets the modification permission to the vendor user.

State
Establish a communication connection with the controller.

operating steps
1. In the menu"Configuration - Educator Configuration", select"User Group"and log in to

the"Manufacturer Personnel"user (switch to super user or higher rights).

2. 2. In the menu bar"Configuration - Instructor Configuration", select" Robot
Communication Configuration"in the submenu.
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3. 3. Enter the IP address and port number of the controller and click Save
4. 4. Rerevelation Instructor (click"System - Rerevelation Instructor"in the menu bar or

slide to close the app and then open the"HSC3-HSpad"app)

picture 8 - 11 Robot Communication Configuration

8.2 Controller configuration

8.2.1 Shaft configuration

The axis group configuration should not be arbitrarily set by non-

debuggers. When configuring, ensure that the models match. After the

setting is completed, check whether the zero point and limit are correct .

The setting authority is the manufacturer's personnel . ( Re-switching

the model will lose the zero point, limit and other parameters, do not

operate arbitrarily, you need to back up the system parameters )

Load classification : light load, medium load, full load.

The nameplate information generally does not need to be changed, and

can be set once at the factory. The set information can be viewed in the

Help Information section.
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Explain the use of axis group configuration, model switching, and load setting

Steps

1. Under the authority of the manufacturer, select the menu bar → Configuration →
Controller Configuration → Axis Group Configuration to enter the axis group configuration
interface.

2. Click the"Modify"button.

3. Select the"Model"drop-down box option and select the robot model.

4. Click the"Confirm"button. ( Note: When switching models, the load will also be switched at
the same time, and the load will be switched according to the load option below )

5. Click the Modify button. (The load can be switched to the robot separately, and the speed
of the robot with different loads is different)

6. Select the"Load"drop-down box option and select the load level;

7. Click the"OK"button

8. Complete the setup after restarting the system.

Figure 8 - 12 Axes group configuration

Note : When changing the load level, it is not necessary to switch the

model again, just follow steps 1, 6~ 8.

setting the number of additional axes is reserved.
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8.2.2 External Run Configuration

The modification permission of this function is set to engineer user and

above.

illustrate Configuring external signals is the process of establishing a

mapping relationship between system signals and IO input and output indexes

(that is, binding the function to IO). After the mapping relationship is

established, the program can be run through the IO signal, and the robot status can

be obtained. All system signals must be configured before they can be mapped to the

corresponding IOpoints. In a systemwithout external signal configuration, there is no

mapping connection between system signals and IO by default.

Note: External configuration can only be operated in teach mode

Input configuration : By binding the specified input signal, by triggering

the input signal, the normal operation of the external program is completed,

such as: enable, load, pause, run the program, clear the alarm, etc.

Output configuration : Display some states of the robot through output

signals, such as: program state, enable state, current mode, area output, etc.

Steps

External input and output configuration :

1 . Select" Configuration → Controller Configuration →Run Configuration" from the
main menu to enter the external operation configuration interface.

2. Click" Input Configuration", select the [Sign] on the left side of the screen, select the
DIN index number on the right, and then click to add" <—"to establish a mapping
relationship, and click to remove"—>"to cancel the mapping relationship.

3. Click"Save"to save the operation.

4. Click"Output Configuration", similar to the above operation, you can set the mapping
relationship of the output.
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picture 8-13 Input configuration for external operation of the welding process
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Figure 8-14 Output configuration for external operation of the welding process

Note: External configuration can only be operated in teach mode.

Note : When the external program is ready, it can be uninstalled through

the uninstall signal. When running a program, you need to suspend the

program first, and then uninstall the program through the stop program

signal

Welding process input signal table

Signal name illustrate Effective way

iPRG_START
Start program signal. Start the loaded user program
to run.

Falling edge takes
effect

iPRG_PAUSE
Pause program signal. Suspend user program
execution.

Falling edge takes
effect

iPRG_STOP _
Stop program signal. Stop the user program from
running and uninstall the program.

Falling edge takes
effect

iPRG_LOAD Loader signal. Load the specified user program. Rising edge takes
effect
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iPRG_UNLOAD
Uninstaller signal. Uninstall the program in the
ready state.

Falling edge takes
effect

iENABLE System enable signal.

Rising edge
enable, set 0 to
turn off enable

iCLEAR_FAULTS _ Clear the error signal.
Rising edge takes
effect

Welding process output signal table

Signal name illustrate Remark

oROBOT_READY

Robot ready signal. This signal is output when the

system initialization is completed and the user

program is in the loaded state and enabled.

This signal will

not be output

during program

operation

oDRV_FAULTS error.

oENABLE_STATE enable state.

oPRG_UNLOAD User program is not loaded. At the same

time , these

signals have one

and only one

signal output

oPRG_READY User program loaded status.

oPRG_RUNNING User program running status.

oPRG_ERR User program alarm status.

oPRG_PAUSE User program pause state.

o LS_MOVING _ The robot is in motion.

oEXT_MODE The system is in external mode.

oREF [ 0] Reference point 1

oREF [ 1] Reference point 2

oREF [ 2] Reference point 3

oREF [ 3 ] Reference point 4

oREF [ 4 ] Reference point 5

oREF [ 5 ] Reference point 6

oREF [ 6 ] Reference point 7

oREF [ 7 ] Reference point 8

External runner configuration :
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After the external program is configured, if it is modified or loaded for the

first time, it needs to be loaded in teaching or automatic mode, and the

program will be updated to the controller.

1.Click the cursor to select any station number, and click the" Configure"button.
(There are 10 station numbers in total, and 10 external programs can be configured
at the same time )

2.pops up, click to select an externally running program.

3.Click the"OK"button to complete the external program configuration.

4.Click "Save" on the operation bar to complete the external program
configuration.

After the input and output and programs are configured, the main program

MAIN.PRG will automatically run when switching to external mode. When

the program is not running, it will be displayed as the program of station 1.

After starting the operation, the current running program will be displayed.

The robot is not at the reference point, please switch to teach mode to move

the robot to the reference point!"error, you need to configure the reference

point in"Reference Configuration" and move the robot to the reference

point.

Note: The program file named MAIN.PRG cannot be configured when
configuring the station program.
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picture 8-15 External Operation - Program Configuration

Reference configuration :

1. Click the"Reference Configuration"button to enter the reference configuration interface.

Reference configuration function: The specified JR register can be

configured as the reference point. When the actual position of the robot is

at the position of the specified JR register (eg : JR[ 0]={0, -90, 180, 0, 90,

0 } ), then The output has been bound to the position signal, and the

precision range can be set. The maximum number of bound JR registers is

8.

2. Click the" Add"button to set the" Reference Number" ," Register" index number,
and"Precision".

3. Click the"OK"button to complete the setting.

mode, it is necessary to add a reference point in the reference configuration., the robot

is not at the reference point, please switch to the teaching mode to move the robot to the

reference point!"error, switch the mode to the teaching mode at this time, and add the

reference point in the running configuration - reference configuration (as shown in Figure

8-13), the back to reference point command needs to be added to the station

program, one station can correspond to one reference point, up to 8 reference points.
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picture 8-16 External run- reference configuration

8.2.2.1 One-key return to welding pause point function

In order to avoid the collision caused by the start of the pause during the welding process, the

pause point detection function has been added. After the pause in the welding process, you need to

return to the pause point to run the program, otherwise the running program will

report"[Resumable] The robot did not return to pause. point, please teach back to the pause

point"error message, the quick way to return to the pause point is as follows:

1. Click the pause icon""in the lower right corner of the teach pendant screen , and

the"Return to Pause Point"button will pop up Press and hold the"Return to Pause Point"button and

the robot will move to the pause point. After opening, stop the robot, and the running speed can

be adjusted by the teaching override.

Note: This function can only be used after the external mode is paused.

2.The pause point data during the welding process is stored in LR[0], click Display-

Variable List-LR in the main menu, select LR[0] (as shown in Figure 8-15), click

the"Modify"button, in the pop-up box Click the"Line to point"button in the middle of the box,

the robot will move to the pause point, click the"Stop Motion"button to stop the robot, and

the running speed can be adjusted by the teaching magnification.
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Figure 8-17 Pause point LR[0]

8.2.3 Encoding/Decoding configuration

This function sets the modification authority to the manufacturer's

personnel user.

illustrate

The encoding function is to map the R register to the output of IO, and set the IO
sequence according to the value of R. This process is binary encoding, and the value of
R is used to encode the corresponding IO sequence value, such as DO[1]-DO[4] and R[1]
is associated, where R[1]=3 (binary 0011b), then DO[1]=1, DO[2]=1, and the rest of DO
are 0; the decoding function is to map the input of IO to R Register, external input
corresponding signal, the controller will decode this signal to R register, for example
DI[1]-DI[4] is mapped to R[2], external input DI[2]=1, then the corresponding R[ 2] =
2 (binary 0010b).

Operation steps

1. Select the Configuration → Controller Configuration → Encoding/Decoding

Configuration button in the main menu.
2. Click to select encoding settings or decoding settings

3. Click the"Add"button to enter the setting interface

4. After the setting is completed, click the"OK"button to complete the setting
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Figure 8-18 Encode/Decode Configuration

picture 8 - 19 Encode/Decode Change Configuration

Example: Code R[0]=42, which is associated with DO[ 0~6 ], the
decimal 42 to binary is 01010100, and the corresponding value of
DO[ 0~6 ] is also 010101, if the output above DO[ 6 ] is
associated Signals, such as DO[7~ 10] are also 0

Decoding is the opposite, convert the associated binary DI signal to
decimal to get a value to the specified R register, such as: associated
with DI[ 0~6 ] = 010101, bound with R[ 1 ], after decoding, R[1]
=42

8.2.4 Zone configuration

This function sets the modification authority to the manufacturer's

personnel user.

Indicates that the area type includes interference area, safe area, shared area, and invalid area.

【Area configuration includes the following parameters 】

Area refers to a spatial extent. Has the following characteristics:

(1) Origin. A reference point for the region relative to some user coordinate system.

(2) Shape (Shape). A region is usually a solid based on the origin, and its shape can be box or
column.

A. Box, with length, width and height.
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box

B. Cylinder, with base radius and height.

cylindrical

(3) Offset value, the allowable error when judging the inside/outside of the area. (The current

system version cannot accurately stop at the edge of the telescopic value, and the

stopping distance varies according to the movement position and speed)

Note : The expansion value can also be understood as the regional wall

thickness. The safe area is equivalent to increasing the wall thickness

inward, and the interference / sharing area is equivalent to increasing the

outer wall. In practical applications, the expansion value should be larger

than the theoretical value to increase security.

(4) Each area is equipped with an external output signal (digital signal, see external operation

configuration for area signal configuration ), which is used to indicate whether the robot position

is inside/outside the area, and whether the external output signal is reversed can be configured.

When the zone parameters are configured successfully, the external output signal will

have corresponding output according to the signal inversion, regardless of zone type.

Signal inversion = true (open state ), output = ON outside the area, and vice versa in the

area;

Signal inversion = false (off state ), enter the zone, zone output = ON, and vice versa outside

the zone ;

(5) The processing mode can be processed according to the relationship between the robot

position and the area (inside/outside) (different types of areas have specific definitions).

Processing modes include:
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A. Ignore it.

B. Error Stop.

C. Warning Stop.

(6) Workpiece selection, which can be selected according to the workpiece calibration to

determine the XYZ direction of the area

Interference area ( Block Area ): refers to the area where the robot cannot enter or stay.

Features : It is normal for the robot to be outside the area, and it will alarm and stop when it

is inside the area.

Features: In teaching mode (jog, jog, space motion) / automatic mode ( teaching,

automatic, external), it will report an error and stop in the area. If the robot alarms in the

area, you need to switch the area type to the invalid area, and then move the robot out of the

area before the robot can perform subsequent movements.

Figure 8-20 Locale Configuration Settings - 1

Area : refers to the area where the robot is not allowed to leave

Features: In teaching mode (jogging, jogging, space motion) / automatic mode ( teac

hing, automatic, external), the robot is normal when it is in the area, and it will stop when

it is outside the area. If the robot alarms outside the area, you need to switch the area type

to the invalid area, and then move the robot to the area before the robot can perform

subsequent movements.
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picture 8-21 Locale Configuration Settings - 2

Share Area: refers to an area that can control whether it has the characteristics of an

interference area, and you can choose to enter the processing mode of this area.

Each shared area is configured with an external input signal (digital signal) to enable the

shared area.

A. In the enabled state, it is normal for the robot position to be outside the area; it responds
according to the configured processing mode when entering the area.

B. In the non-enabled state, the shared area has no effect.

Features: In teaching mode (jogging, jogging, space motion) / automatic mode ( teac

hing, automatic, external), the robot is normal when it is outside the area, and it will

report an error and stop when it is in the area. If the robot alarms in the area, you

need to switch the area type to the invalid area or select the no-processing mode, and

then move the robot out of the area before the robot can perform subsequent

movements.
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picture 8-22 Locale Configuration Settings - 3

Invalid area : refers to the area where the current setting is invalid. Only the output

signal detection is performed in this area, and no error reporting or shutdown is performed

in this area.

Example : Suppose the robot is at a certain position, and an area is to
be generated at this position, the actual position of XYZ coordinates
is {600,-100, 100} to generate an interference area at the current
position of the robot, set the length to 200, the width to 100, and the
height to 50, the expansion value is 5, the range of a box-shaped
area generated at this position is (by default, it is generated in the
positive direction, if the workpiece coordinate is called, the direction
of XYZ is determined)

X=[ 59 5,805
] Y=[ -
105,50] ]
Z=[95, 155]
Remarks : The interference area/shared area is the super area when
XYZ enters the XYZ area, and the safe area is the super area when
any axis of XYZ exits the area.

8.2.5 Timeout setting

This function sets the modification authority to the manufacturer's

personnel user.

Description The timeout setting is to avoid unlimited waiting for the robot program. By
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setting a time and using it with the WAIT timeout instruction, during the execution

of the program, when the WAIT instruction is executed (except for the WAIT

TIME= value, WAIT TIME does not have a timeout function), due to the condition

When it is not satisfied that it is in a blocked state, after the waiting time exceeds

the set time, it will jump to the corresponding program line to continue execution.

The time unit is milliseconds (ms). If not set, the default timeout is 10s.

Operation steps

1. Open themenu and click"Configuration → Controller Configuration → Timeout
Settings"

2. Check the time edit box and edit the time

3. After setting, click the [Settings] button, and the settings will take effect
immediately.

picture 8 - 23 timeout setting

In addition to the timeout setting, when the WAIT command is executed

and the waiting state is blocked, the waiting can also be released by

clicking"More → Release Waiting" in the lower menu. After clicking

the"Release Waiting"button, the pointer will move to the next line, but

the robot does not The program of the next line is executed, and the

corresponding IO output of the robot is adjusted accordingly

(equivalent to being in a paused state at this time), and the"Start"button

needs to be clicked again to run the program. If there is no instruction in

the next line, return to the first line of the program.
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8.2.6 Controller IP configuration

picture 8 - 24 Controller IP configuration -1

State

You can configure or change the IP addresses of multiple controllers.

operating steps
1. Log in to the Debugger user (switch to Super user or higher rights).

2. On the menu bar, choose > Configuration > Controller Configuration >
Controller IP Configuration.

3. Click Enable to configure IP Address and Subnet Mask. You can configure a
maximum of three controller IP addresses.

4. After the configuration is complete, click Save to make the configuration take
effect.

5, by clicking the" Enable"and" Disable"button, you can adjust its network status.

picture 8 - 25 Controller IP configuration -2
Hint
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The IP address cannot be the same as the controller IP address. For example,
10.10.56.213 is set to 10.10.56.214 or conflicts with the new ip address in the old n file.
Otherwise, the system module may fail.

Avoid using the segment ID whose IP address is 192.168.2.

8.2.6.1 IP Describes and configures applications
Standard electrical cabinet control Device IP specification

object Default IP

LAN0 IP：10.10.56.214 Port：23234

IP：90.0.0.1 Port：23234

LAN1/ECAT IP：192.168.2.214 Port：23234

Drive and control integrated electric cabinet Controller IP address

object Default IP

Demonstrator connector IP：10.10.56.214 Port：23234

MLAN IP：10.10.57.213 Port：23234

LAN1 IP：10.10.58.212 Port：23234

LAN2 IP：10.10.59.211 Port：23234

Educator IP The educator IP can be viewed and set using the"Ethernet"application on the educator

object

IP address 10.10.56.123

Netmask 255.255.255.0

Gateway address 10.10.56.1

Note: The IP address and Gateway address must be on the same network segment.

8.2.7 Cooperative group configuration
State

Cooperative group refers to the whole after the combination of the robot shaft group

and the external shaft positioner. The cooperative configuration of the positioner is the

process of specifying the cooperative group number and configuring the external shaft that

moves cooperatively with the robot. The synergetic group number is called by the synergetic

instruction COORD_NUM in PRG, and the system will carry out the synergetic movement

after the synergetic instruction is called.
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picture 8 - 26 Cooperative group configuration

tag state

【 Logical axis number 】 Logical axis number indicates the index

number of all axes in the system (the

system supports the point information of 9

axes). The logical axis number of the 6-axis

robot arm is 0 to 5, and the logical axis

number of the external axis is arranged in

the sequential order, which is 6,7,8.

【type】 That is, the type of external shaft positioner, the
shaft type has a rotating shaft and a
linear shaft.

1. On the menu bar, go to → Configuration → Controller Configuration → Collaborative
Group Configuration.

2. Click the Synergy Group Number drop-down box and select the synergy group number.
3. Click the"Modify"button, select the" Logical axis number"drop-down box, and select the

corresponding external axis index number.

4. Click the"Type"drop-down box option and select the axis type (X ~C, currently supports the
rotation axis type, select X).

5. Click the" Save"button to bind the coordination group number to the logical axis number of
the external axis.
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When configuring a cooperative group, if two external axis
positioner are required to cooperate, configure two logical axes.

8.2.8 Back to zero program configuration

picture 8 - 27 Back to zero program configuration

picture 8 - 28 configuration program

State

One key back to zero function is divided into two parts: one key back to zero
program configuration and one key back to zero operation.

Return-zero program configuration is a PRG program that configures the return-zero
motion to execute.

One-click return to zero operation means that the system executes the return to zero

motion program. When the return to zero signal is triggered, the system will automatically

execute the program, thus simplifying the operation steps for the manipulator to return to the
set zero point.

Return to zero program example:

LBL [X]
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WAIT DI[10]=ON ‘Protection: Wait for the signal to meet the execution,

otherwise it has been blocked in this line

LR[1]=LPOS ‘Gets the current position: Assign to the LR[1] register

IF LR[1][0]<200,GOTO LBL[1]

IF LR[1][0]>=200,GOTO LBL[2]

LBL [1]

L P[0] ‘Back to zero transition point 0

LBL [2]

L P[1] ‘Back to zero transition point 1
L JR[0] ‘return zero
Back to zero program configuration
Controls

1. Choose > Configuration > Controller Configuration > Back to Zero
program Configuration from the menu bar.

2. Click the"Configuration Program"button and select the"back to zero
program".

3. Click [Save] button to complete the setting.

One click back to zero operation

1. In manual mode, enable the function when the main program is idle.
2. Click the"one-click back to zero"icon on the right to execute the zero back

program.

Tip:

The prerequisite for executing the return to zero program is enable.

The return to zero program must be executed when the main program is not loaded
(idle).

The return-zero program can be executed only in manual mode and
automatic mode. AUCTECH robot operation and programming instructions

Return to zero immediately in manual mode or confirm twice in automatic mode.

Back to zero After the program is written or modified, the latest program must
be loaded before being updated to the controller.

8.2.9 Speed configuration

8.2.9.1 Safe speed trigger and recovery
State
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In practical applications, the robot runs automatically and quickly in the safety

bar. When the safety gate is opened and entered into the fence, the running speed of the robot
arm needs to be reduced to prevent accidents in order to ensure safe

production. When the gate is closed, the robot arm can be automatically restored to the
original running speed for production, or the running speed can not be

automatically restored. Instead, the speed magnification is modified by manually
operating the indicator magnification button.

picture 8 - 29 Speed configuration
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Speed multiplier after triggering, that is, after the corresponding IO signal is

configured, the input value range of safe speed is [1, 100]. If the corresponding IO signal is
configured to take effect, or if the robot movement speed is larger than the set safe speed value, it
will automatically switch to the set safe speed.

automatically restore the original speed multiplier switch. When the

corresponding IO signal is turned off, the robot will restore the original motion multiplier for
movement. When the robot is turned off, the velocity ratio of the robot after
maintaining the trigger signal is simulated.

Automatic recovery of the original speed multiplier function is enabled：

Prerequisites: Set the triggered speed multiplier V1 to 10%, enable the auto-recovery
function, set the security signal DI[200],
set V to the current speed.

Case one：

DI[200]=ON,V2=100%

DI[200]=OFF ‘Safety speed trigger takes effect V=V1=10%

DI[200]=ON ‘V=V2=100% (Speed recovery)

Case two：

DI[200]=ON, ‘V2=100%

DI[200]=OFF ‘V=V1=10%

‘Modified magnification，V3=50%

DI[200]=ON ‘Speed recovery V=V2=100%
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picture 8 - 30

Configure the input I/O index of the iSAFE_SPEED flag bit in Running configuration.

Tip:
IO trigger signals can be virtual signals.

The system default magnification value for safe speed is 10.

The Safe Speed trigger and recovery function takes effect only in

automatic, external mode.

If iSAFE_SPEED is not configured, the safe speed
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triggeringand recovery functions do not take effect and
iSAFE_SPEEDtakes effect at a falling edge.

IO Trigger change speed magnification is not mutually
exclusive with other change Speed magnification Vord operations, the
user can still change the speed magnification using the
instructor change magnification or the VORD command.

For the multi-axis group scenario, only the velocity multiplier of
the robot group is currently supported, and the external axis
group is not considered.

The speed multiplier set when running the program should

be lower than the actual running rate, if the speed set higher than the
running speed, no response.

Operation procedure
1, in the debugger above the user group.

2. Choose Configuration > Controller Configuration > Speed Configuration from the
menu to enter the configuration page.

3. Set the triggered Speed multiplier and Automatically Restore the original speed
multiplier parameters and save them.

4. Choose Configure Controller Configuration and Run Configuration from the menu
bar. In the input configuration text box, select the DI index to match the

iSAFE_SPEED signal.

8.2.9.2 Triggering and Recovering the Reset Speed
State

Reset speed function: After the system alarms, click [confirm alarm] to reset

the robot arm, the system will automatically adjust the current magnification to the set value.
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picture 8 - 31 reset speed

When the function is configured, the function takes effect only after the system throws
an alarm and then clicks the"alarm confirmation"button. If the system has no alarm thrown
directly click the" alarm confirmation"button, the function will not take effect.

This function needs to configure the speed ratio of the system after the alarm is
confirmed, and the configuration information is stored in the system in a file.

Tip:
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The system default multiplier value for the reset speed is 10.

Reset speed trigger function takes effect only in automatic, external mode.

Reset Speed Trigger Change Speed multiplier is not mutually exclusive with other speed
multiplier change Vord operations. Users can still change the speed multiplier from the instructor
or through VORD instructions.

When the speed is triggered, the indicator displays the message Reset Speed has
triggered.

Before triggering the reset speed, it is necessary to judge the current speed ratio of the
robot:

If the current speed multiplier is greater than the configured reset speed

multiplier, the function touch takes effect after the function is configured, that is, the reset speed
can be triggered.

Otherwise, the function cannot take effect, that is, the reset speed cannot be
triggered, and no error message is displayed.

For the multi-axis group scenario, only the velocity multiplier of the robot group is
currently supported, and the external axis group is not considered.

Operation procedure
1, in the debugger above the user group.

2, select the menu → Configuration → controller configuration → speed

configuration,"Reset speed"TAB below to enter the configuration page.

3, set the"speed ratio after alarm confirmation"parameter and save

4. Select Enable to enable the function.

8.2.9.3 Setting Signal Speed

State

In practical applications, the robot arm will enable different operation

magnification according to different application scenarios, and the function supports user-
defined configuration of signal speed.
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picture 8 - 32 signal speed

After the function is configured, enable the function. Otherwise, the signal speed
triggering function does not take effect.

This feature also requires the following configuration options:

Trigger signal and trigger mode (ON/OFF)

The speed multiplier of the system after the signal is triggered

Function enabled

Function trigger Using the signal edge mechanism, the configured IO signal
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edge triggers the robot arm to adjust the running speed multiplier to the set value.

The configuration information is saved in a file.

Configuration description: R[N].X =OFF/ON, the value is V N
is the R register number;

●X is the number of bits, also refers to the number of bits in binary. The user can set the
value of the R[N] register, the corresponding value data from decimal to binary control signal
speed output;

OFF/ON is the signal switch;
●V is the multiplier;
Prerequisites: The corresponding signal speed has been configured

Case 1: Modify the signal configuration according to the instruction
'Suppose the current multiplier is 50
R[150].1 =OFF 'The current speed multiplier is unchanged
R[150].1 =ON 'The current speed multiplier is set to 20
Case two: Modify the value of the R register and respond to the signal speed
'Suppose the current multiplier is 50
R[150] =60 'Current speed multiplier unchanged (register data is 60,

decimal to binary is
0011 1100, the first digit is 0, which is OFF)
R[150] =70 'The current speed multiplier is set to 20 (register data is 70,

decimal is converted to binary
The system is 0100 0110, the first digit of which is 1, which is ON)

Tip:

IO trigger signals can be virtual signals.

Signal speed trigger function only works in automatic, external
mode.

IO Trigger change speed magnification is not mutually exclusive with

other change Speed magnification Vord operations, the user can still

change the magnification from the instructor, or change the speed
magnification using VORD commands.

When the speed is triggered, the instructor will issue the
message" Signal speed has been triggered".

For the multi-axis group scenario, only the velocity multiplier of the
robot group is currently supported, and the external axis group
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is not considered.

Operation procedure

1, in the debugger above the user group.

2, select the menu → Configuration → controller configuration → speed
configuration, the"signal speed"TAB below to enter the configuration page.

3. Set"Signal speed configuration item list". Click the corresponding list and
select" Change"button to enter the pop-up window of signal configuration.

4, the signal configuration register can be input [0,999], the second input box
can be input [0,7], the multiplier speed value can be input [1,100]

5. Select Enable to enable the function

8.2.10 Background program configuration
Instructions

Background program configuration, the user can configure the function of

automatically allowing the background program to power on, the background

program can configure the controller to run the main program at the same time, can run the
logic PRG program in the background at the same time, to achieve

multithreading function. The main program group mask is 0, and the multithreaded logic
program group mask is *. You can also RUN the run daemon command in the main
program to invoke the background program.

picture 8 - 33 Background program configuration
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Operation procedure

1. Choose → Configuration → Controller Configuration → Background
program configuration from the main menu to enter the background program
configuration interface.

2. Click Select Program to select the program that will run automatically on

power-on.
3. Click Enable to enable the function.

4, set the number of 4ms program cycles, the default is 1.

5. The function takes effect after the cabinet is restarted. If the program group
mask is 0, the setting fails!

Command to add an operation step

1. Select the line above the instruction line that you want to insert.
2, select instructions → other instructions → Run the program.

3. Click the"Select Subroutine"button and select the logic program.

4. Click the"OK"button.

5. Click the OK button in the operation bar to add the RUN command.

Constraint condition
The background program runs subject to the following conditions:

Enable condition. When the program is running, disable the enable, and the main
program ends running. After this function is enabled, the system can resume running. The
background RUN program does not end.

servo alarm. When the program is running, the servo alarm, the main

program will end the operation. When the alarm is lifted, the operation can continue to resume.
The background RUN program does not end.

Indicates the error status of the main program, which affects the running of
background programs

External signal output according to the main program status output.
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external signal input: load the main program, but the background program will be
loaded when the main program is loaded; PAUSE is only valid for the main program; Start,
uninstall, and stop are valid for both programs.

When switching to the background program interface, not controlled by the
instructor keys (pause, uninstall, back, Start).

The background program is only controlled by the program control softkey, and the
main program is also controlled by the program control softkey.

resumed after being suspended. Run midway pause, the main program and
background program can be separately controlled temporarily, can be separately
controlled continue to resume operation.

Tip:
RUN If you modify or edit the logical program, the system

automatically delivers the latest program to the system. The ABORT,
END and PAUSE commands in multithreading control only the
current program and do not affect the main program.

Only one set of logical PRG (background) programs and

one set of robot motion control (main) programs are allowed to run
simultaneously.

After the automatic running program is configured and
powered on, loading the command that contains the RUN
background program in the main program fails.

When the RUN background program is executed, the

robot stops running and reports an error if a motion command is found
in the program whose group mask is"*".

The program after RUN must be in the non-running state.

A running program cannot be RUN by using the run command.

Otherwise, an alarm is generated when the RUN command is

executed. RUN program alarm description: When the program is

executed, the main program or RUN program appears alarm

information, which is displayed on the demonstrator. For the alarm
priority, there is no main program and RUN program, and the same
priority displays the last alarm message.
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8.2.11 Path holding function
State

The path hold function means that the robot arm is moved after the program is paused,
and the robot arm will return first when the program is started The function to pause the

position and then move again. When this function is enabled, the current execution pointer can
be moved after the program is suspended. When the startup

program is run, the robot arm will move from the current position to the target point specified
by the new pointer line, and the trajectory changes greatly at this time. In

order to prevent collision, the user needs to be prompted to confirm whether to start the
program execution.

picture 8 - 34 Path holding function

Operation procedure

1. Choose > Configuration > Controller Configuration > Path Hold from the menu
to enter the configuration page.

2. After setting the allowable value of input position deviation, click Save to save
the data to the controller. The position deviation value is assumed to be 50mm and the attitude
deviation Angle is set to 5° by default.

3. Select Enable to enable the function
Tip:

During path backtracking, users need to pay attention to the
environment around the robot arm to avoid potential safety risks such
as collisions.
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8.3 Dynamic function

8.3.1 Installation attitude setting

State

Under normal circumstances, the robot arm is installed on a smooth table or ground,
and no operation is required in this case. If the robot arm is mounted in reverse, wall-
mounted and side-mounted, the current installation attitude needs to be set when the
dynamic related functions are used. The configuration page is displayed.
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picture 8 - 35 Installation attitude setting
Operation procedure

1. Choose from the menu → Configuration → Dynamics function → Installation
posture setting to enter the setting page.

2. Select the installation posture according to the actual robot installation
posture

3.g is the local acceleration of gravity
4.Click the"OK"button to save the data to the system and restart the

controller to take effect

Tip:

1. Setting the installation attitude is to improve the accuracy of the
dynamic model and ensure the precision of the dynamic model. If you
need to flip to use, you should first set the installation posture during the
flip, and then identify. The safety posture should also be set correctly
before using the dynamics feature.

2. After changing the installation attitude, the robot arm

body needs to perform friction identification again! Otherwise, it will
affect the related functions of the robot arm system, which will lead to
safety risks such as crashes!

8.3.2 Body friction identification function

State

Robot dynamics parameters are crucial to the accuracy and reliability of the

robot, and each parameter is required before the factory Configured in the control system,
no external identification process is provided.
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Figure 8-36 Body friction identification

Operation procedure

1. Choose > Configuration > Dynamics Function > Body friction Identification from the
menu bar. The body friction identification page is displayed.

2. In manual mode, select any trajectory and click [Return to starting point] button, and the
robot will automatically move to the starting point

3. After the movement reaches the point, click the" Start incentive"button, and the
system will automatically start incentive and collect incentive data

4. Repeat the above steps to complete the stimulation of the remaining tracks.
5. After all trajectories are energized, click the" Identification"button to start the

system's dynamic parameter identification operation.

6. Click [Save] button to save the relevant identification data into the controller.
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Attention:

The model of the mechanical arm has been identified before

delivery. Do not identify it unless necessary.

The excitation starting point of the trajectory is automatically

generated by the system. During the recognition process, please pay

attention to the environment around the robot arm and keep away from

it.

The excitation starting point of the trajectory is automatically
generated by the system.

Move to the start of the track in manual mode only, track
excitation in automatic/manual mode.

During the excitation process, if abnormal circumstances (such as
disable, emergency stop, error occurs, click"Stop excitation"button, etc.)
occur, the robot movement will stop, the excitation fails, and

the current trajectory incentive data will be cleared.

If ontology identification is not implemented on the model,
collaboration related features cannot be used

Supported models

Not all models are compatible with the dynamics, please ask the relevant technician for
details.

8.3.3 Load configuration function

Function description

Load configuration is a function to let the system know the current load of the robot by
modifying the dynamic parameters, which can be obtained by self-input or load
identification. The correct setting of load and load parameters can improve the robot

action performance and effectively play the robot dynamics related functions, including collision
detection and drag teaching functions. To avoid errors or adverse effects caused by relevant
functions, the robot should identify the load before use, and select the load number.
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8.3.3.1 Dynamic load switching

state
Dynamic load switching is a function that allows the robot to re-obtain the

relevant load parameters under the current load number by switching the load

number, so as to know the current load of the robot. There are 16 groups of load number
data in the system. Load switching can be done in two ways, directly

switching through the demonstrator button and switching through the command.
Operation procedure
Method 1:

Click the robot speed level or load status display box in the status bar of the
instructor. If the current parameter is dynamic load, click the load number selection drop-
down box to select the corresponding load number.

图 8-37 负载切换

Method 2: Set this parameter in the program using the PAYLOAD assignment command.
1. Select the line above the instruction line that you want to insert.

2. Select instructions → Dynamics instructions.
3, slide down the drop-down box to find the"PLAYLOAD"option and click Select.

4. Move the cursor to the right input box and enter the value.

5. Click the"OK"button to add instructions

.
Program example：

PAYLOAD=1 The value ranges from -1 to 15. The default value is -1 no load
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Attention:

When the load of the robot changes, it should be switched to the
corresponding load number in time; otherwise, the motion accuracy may

be decreased, the collision detection may be false positive, or the

dragging power may be adversely affected.

The load number switching policy of the loader and unloader is the
same as that of the tool job switching. The current load after the program
is uninstalled is the same as that used before the program is loaded.

8.3.3.2 Load parameter configuration

Instructions

Load parameter configuration is to set the load mass, centroid position, inertia tensor
and other parameters. You can perform the following operations to configure load
parameters:

1. Manually edit load parameters: If the load parameter information is known, you
can directly modify the load parameter value. After saving, the load parameter
configuration is complete.

2. Load parameter information is automatically generated based on load

identification. If the load information is unknown, you can configure load parameters in this
way.

This section describes the procedure for Mode 1

Method 1: Manually edit load parameters.
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Figure 8-38 Setting load parameters -1

1. On the menu bar, select → Configuration → Dynamic Function → Load
Configuration.

2. Click the Load Number drop-down list box and select the corresponding load
number to go to the parameter page The information displayed on the interface is the load
parameter information of the load number, which is not being used by the robot The load
number used).

3. Click the"Description"input box to make remarks about the load number.

4. Select the corresponding row in the list and click the input box of Value to
manually modify the load parameter value of the corresponding serial number.

5. Click Save to save the modification result and complete the load parameter
configuration.
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Warning:

Since BR robot is a model with internal rotation structure, users

should pay attention to the following two situations when manually

modifying load identification parameters:

1. Avoid the position of the joint axis of the robot's third axis
approaching 270°

2. The fourth joint axis of the robot should be in the range of 0~
180°

If the machine is loaded, the first solution is recommended.

And pay attention to avoid three-axis close to 270° resulting in load
interference with the body.

Procedure For Mode 2

Method 2: Automatically generate load parameter information based on load
identification.
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Figure 8-39 Load Parameter Settings -2

1. On the menu bar, choose > Configuration > Dynamics Function > Load
Configuration.

2. Click the Load Number drop-down list box and select a load number based on the
load number.

3. Click the"Load Identification"button to enter the load identification setting
interface.

4. Click the" negative direction range"or"positive direction range"input box to reset the
relative motion range of A3 to A6 axis based on the current position (the

default motion range of positive and negative direction is automatically set according to the
positive and negative soft limit range).

5. Click the" trial run"button to start the slow trial run track and test whether the
operating environment is safe.
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6. Click the"Start identification"button to start the identification track at high speed
(this process belongs to the load identification data acquisition process, and the same track
is repeated for ten times).

7. After identification, click"Save"button to complete the load parameter
configuration.

Attention:
Track trial run can only be carried out in manual mode,

high-speed run identification track can be carried out in manual or
automatic mode.

Before load identification, corresponding load should be
attached to the end of the robot and the robot system is idle.

High-speed operation identification trajectory During the

trajectory, the collision detection function is automatically turned off.

8.3.4 Collision detection function

Function description

Collision detection is a function that quickly detects and stops the robot when it is
impacted by external forces, which effectively enhances the safety of the robot. This function
is automatically turned on from the moment the system is powered on, and takes effect in

manual, automatic and external modes, which is the guarantee for
maintaining the safe operation of the robot.

8.3.4.1 Collision detection switch

Instructions

Collision detection is automatically turned on when the system is powered on after
friction identification. The function can be turned off briefly by the program instruction
COL_DETECT. This directive has the same scope as global variables.
Program example：

COL_DETECT = OFF ‘Collision detection is turned off while the program

i s running

Operation procedure

1. Select the line above the instruction line that you want to insert.
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2. Select instructions → Dynamics instructions.
3. Slide the drop-down option to find the"COL_DETECT"option and click Select.

4. Click the cursor to locate the input box on the right.
5, click the"Other"drop-down box option, find the"OFF"or"ON"option and click.

6. Click the"OK"button to add instructions.

Attention:

After this function is temporarily disabled by program

command, it will automatically switch to the enabled state when the
program is not running, such as uninstallation, error, suspension,

completion of the program, or online editing. When the program
resumes running, it automatically switches to the closed state.

dynamically-supported models and after ontology

identification of the robot, the collision detection system will be
automatically turned on after power on.

The current version of the collision detection response mode is to
slow down and stop.

8.3.4.2 Collision detection sensitivity

Instructions

The larger the collision detection sensitivity value, the higher the detection sensitivity.
The collision detection sensitivity can be modified on the "Collision Detection
Configuration"interface of the instructor, or by the COL_GUARD_ADJUST instruction in
the program.

This section describes the procedure for Mode



Welding Process System Instruction Manual

97

Figure 8-40 collision detection sensitivity

1. On the menu bar, choose → Configuration → Dynamics Function →
Collision Detection Configuration.

2. Click the"Modify"button and enter a value in the"Collision Detection
Sensitivity"field. The value ranges from 1 to 100.

3. Click the"OK"button to save the modified sensitivity value.
Procedure For Mode 2

Modified by the COL_GUARD_ADJUST command.

1. Select the line above the instruction line that you want to insert.

2. Select instructions → Dynamics instructions.
3, slide down the drop-down box to find the"COL_GUARD_ADJUST"option and click

Select.

4, click the cursor to locate the right input box, you can enter 1-100 range of
values; Or click the"Register"drop-down box option, find the"R[]"option and click,
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and enter the R register serial number in the R[] index box.

Program example 1：

COL_GUARD_ADJUST

= 50 Program example 2

：

COL_GUARD_ADJUST = R[1]

‘Set the collision detection sensitivity to 50

‘Set the collision detection sensitivity value to the
value in the R[1] register

Attention:

Configure the Collision Detection page only after you have
identified the body friction.

Running configuration Adds the oCOL_STATE flag for I/O

configuration. When collision detection is enabled, oCOL_STATE
outputs the ON signal. When collision detection is disabled,
OCOL_STATE does not output the signal.

Sensitivity values are also calculated based on the

corresponding load number. To switch different loads, the
corresponding sensitivity value should be set.

detection Collision detection is based on body friction

identification and load parameters. If the correct parameters are not filled
in, the collision will be false positive.

When collision detection sensitivity is set to 1, this function is
disabled by default.

8.3.5 Drag the teaching function

Instructions

The operator directly drags the robot body to teach, and adjusting the drag
compliance coefficient can improve the drag effect to a certain extent.
Operation procedure

1. Press the drag button at the end of the robot's six axes.

2. After the robot is enabled, the robot can move in any direction applied by the hand.

Attention:

Drag is only allowed in manual mode.

It is necessary to identify the load of the robot and use this
function after calling the corresponding load number; otherwise,

5. Click the"OK"button to add instructions.
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the robot should identify inaccurate data, which will cause
dangerous situations such as arm drop.

8.3.5.1 Drag the teach Settings

Instructions

Drag teaching Settings You can select joint drag mode or Cartesian drag mode, and set
the drag compliance according to the drag mode. The greater the drag
compliance coefficient, the smoother the drag.

Operation procedure

Figure 8-41 Dragging the display Settings
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1. On the menu bar, select → Configuration → Dynamics Function → Drag the teaching
Settings.

2. Click the"Modify"button to set the desired value in the compliance drag bar of the
corresponding axis. The value range is 1-100.

3. Click" OK"to save the modified drag compliance coefficient value. The parameter setting
takes effect immediately.

Tip:

You can enter the Drag Settings page for configuration only after
you have identified the body friction.

8.3.5.2 Drag track recording

Instructions

The user uses the drag function of the cooperative robot to drag the robot to

teach the trajectory. The software will record the movement trajectory of the robot

shown by the user, and then generate the corresponding robot program, which saves the point
position of the teaching trajectory shown. The execution of the program
can complete the repetition of the teaching trajectory shown.

Operation procedure

1. New track:
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Figure 8-42 Track recording

1. On the menu bar, choose → Configuration → Dynamics Function → Drag track
recording.

2. Click the"New"button to create a new track. The content box in the middle will display
the newly created track accordingly

Eight more tracks can be displayed, that is, a maximum of eight new tracks can be created.
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Figure 8-43 New trajectory
Select a track in the middle content box and click the"Configure"button to pop up the

following interface (Figure 8-44）

Figure 8-44

Function record DI: I/O (input IO) that is recorded simultaneously during track
recording, that is, drag recording

The change of the IO is recorded at the same time. The current version only supports
recording one IO.

Function trigger DO: replicates the IO (output IO) that changes the recorded I/O signal.
It should be noted that function record IO and function trigger IO cannot be
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set to the same IO.

point sampling interval: a point is selected at intervals of several points during the
generation of the trajectory. The default value is 5, which is also the minimum
value, that is, a point is selected at intervals of 5 points on the basis of the original

trajectory to generate the trajectory. The greater the value, the lower the accuracy of the
recorded and reproduced trajectory.

point execution cycle: That is, the movement time from one point of the robot's

total trajectory to the next point, in ms, with a minimum value of 20 and a maximum value of

3200. It should be noted that this value should be used reasonably with the point sampling

interval. If the point sampling interval is set to 10, the point execution period should be set to
10*4 =40. Then, on this basis, fine-tuning is carried out. The

smaller the value, the faster the robot will be when the trajectory is reproduced, and the
slower it will be when the trajectory is reproduced. If the setting is improper, the robot may
have super-acceleration when the trajectory is reproduced
Such alarm (corresponding to the program SEC instruction).

trajectory smoothness: The setting range of this configuration item is 1-100. The larger

the value, the higher the trajectory smoothness (corresponding to the program CNT

instruction). After the trajectory is created and configured for the first time, the trajectory

teaching has not been performed at this time, so the"Generate"button

cannot be clicked to generate the trajectory. At this time, you need to click
the"Teach"button to start the track recording.

2.Drag the teaching track:
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Figure 8-45

The teaching status is displayed on the track teaching interface. The image above
shows"wait for drag to teach signal"which means soft at this time The device is waiting for
the user to give a trigger signal. When the user presses the input drag teaching button at the
end of the flange,The interface will change to"Wait until the dragging is complete", as shown
in the following figure (Figure 8-46)

.

Figure 8-46
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recording, and the software will record the robot movement trajectory of the user's
teaching in real time. The recording duration is at most one minute, and the parts of the
track after one minute are not recorded.

If the user wants to cancel the admission, he can click the"Cancel"button, and the

software will return to the previous interface for creating a new track, and the user can

perform Step 1 again to enter the interface for recording the track.

3.Generate and save tracks：

Figure 8-47

After the recording is finished and the robot is given the end teaching signal
according to the robot's operation, the software will automatically enter the save page.
As above, the status display above the software will be changed to the

following, which means that all the tracks have been recorded, and then you only need
to configure before generating the track file.

On the save page, you only need to set" track name", that is, the name of the last
generated track file. Users can fill in it at will. Finally, after clicking the"Generate"

button, the software will generate the track file, and the generated result will be
displayed in a pop-up window. The effect picture is as follows.



Welding Process System Instruction Manual

106

Figure 8-48
When the system displays"Generated successfully! The latter indicates that the

software has successfully generated and saved the corresponding trajectory file. The

execution of the corresponding file can make the robot repeat the trajectory of the dragged

teaching. If you want to re-record this track or a new track or a new track, click the"Back

to Home"button to return to the initial interface, and perform the above operations again to

teach the new track.

Tip:

You need to create tracks before dragging them. A maximum of eight
tracks can be managed online at the same time.

The drag signal for the collaborator is the drag track button at the
end of the flange.

In general, a track can be generated repeatedly after being

recorded once. If you change the last three items of the above

configuration items, click Generate again. In this case, the track file will
be generated again according to the configured parameters.
After clicking the"Clear"button, all the current track data will be
cleared, and you need to create a new track after clearing.
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9 Display functions

9.1 Displaying digital inputs/outputs

The modification permission of this function is set to engineer user and

above.

input terminal REAL can only give signals through real external pulses,

and VIRTUAL can give pulse signals through the teach pendant.

Steps

1. Select Display→Inputs/Outputs→Digital Inputs/Outputs in the main menu.

2. Click to select a specific input/output, and operate the IO through the buttons on the
right side of the interface.

picture 9 - 1 digital input
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picture 9 - 2 digital outputs

serial number illustrate

serial number Digital input/output serial number

io number Digital input/output IO number

value

Input/output terminal value. If an input or output is TRUE, it is

marked red. Click the value to toggle the value to TRUE or

FALSE.

condition

Indicates that the digital input/output terminal is real IO or virtual

IO, the real IO is displayed as REAL, and the virtual IO is

displayed as VIRTUAL.

illustrate Add a description to this digital input/output.

-100 Switches to the previous 100 inputs or outputs in the display.

100 Switches to the next 100 inputs or outputs in the display.

toggle Switchable between virtual and real input/output.

value The selected IO can be set to TRUE or FALSE.

illustrate
Add an explanation to the digital input/output of the selected row,
and click to change it after selecting it.

save save IO description
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9.2 Display the actual position

All users of this function can view the actual position of the robot.

Operation steps

Select Main Menu Display →Actual Position. The axis angle, Cartesian actual

position, and encoder value will be displayed.

State

Cartesian actual position:

Displays the current position (X, Y, Z) and orientation (A, B, C) of the TCP.

Axis-related actual position:

The current positions of axes A1 to A6 are displayed. If there are additional

axes, the positions ofthe additional axes are also displayed.

While the robot is running, the actual position of each axis is updated in real

time.

picture 9 - 3 Actual position of the robot

9.3 Variable List

The workpiece coordinates of this function tool can only be modified by

manufacturer personnel, and can be modified by R, JR, LR register

engineer users and above, and can only be viewed by production users.

Steps

1. Select Main Menu Display →Variable List. A list of related variables will be
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displayed.

2. Click on the list of different variables, the related variables will be displayed.

3. The function buttons on the right can be used to turn pages, modify and save registers.

4. All modified operations must be saved to the file after clicking Save.

setting the register, you need to click [ Save ] to save it. If it is not saved, it

will be lost after power off and restart.

Description :

Variable lists are used to store different types of register data

UT: Tool coordinate system variable

UF: base coordinate system variable

R : Numeric register

JR: Joint type coordinate register

L R : Cartesian coordinate register

picture 9 - 4 variable list

9.4 Functions associated with register description and
IO description and program line

modification permission of this function is set to engineer user and above.

State

After enabling the function of register description and IO description associated with

the program line, you can see the description content of the register list and the user record on

the IO list on the program interface of the
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teach pendant.

Steps

1. Open the program, and click"More → Start Instructions"in turn.

After opening, you can see the corresponding instructions in the program. After opening

the instructions, the procedure is as follows:

J JR[1:HOME] //JR[1] is described as HOME in the register list

R[2]=R[1: Number of times ]-1 //R[2] hasno description in the register list, and the

description of R[1] in the register list is"number of times"

DO[0 : Grab ]=ON //DO[0] in the IO list is described as"grab"

2. Open the program, click"More → Close Instructions"in turn, you cannot see the

instructions after closing.

After closing the description, the program is as follows:

J JR

R[2]=R[1]-1

DO[0]=ON

The description content cannot be changed in the program line. If the
register index/ IO index / description content is changed, the
corresponding descriptioncontentwillalsobechanged inreal time.

9.5 IO status correlation display

modification permission of this function is set to engineer user and above.

Explain that after the IO status correlation display function is turned on, the corresponding IO

status can be seen on the program interface of the teach pendant. When the function

is turned off, it will not be displayed. It is similar to the register description and IO

description and the program line correlation function.

Operation steps

1. Opentheprogram, andclick"More → OpenStatus"in turn.Afteropening,
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you can see the corresponding IO status in the program. After the

state is turned on, the procedure is as follows:

DO[1:ON]=OFF //DO[1] is currently ON, running this command will adjust it to OFF

DO[2:OFF]=DI[1:ON] //The current state of DI[1] is ON, and the current state of DO[2] is

OFF. Running this command will adjust the state ofDO[2] to OFF

2. Open the program, click"More → Close Status"in turn, you cannot see the IO status

after closing.

After closing the description, the program is as follows:
DO[1]=OFF

DO[2]=DI[1]

①When one of the programs is opened and closed, when the next
program is opened, the program status display is consistent with the
previous program, that is to say, the button operation of the previous
program will affect all programs. The default is off (including restart
after power failure). when loading the program.
②When it exists at the same time as IO description, it is performed in
the order of displaying the status first, and then displaying the
description.
③ When the IO state changes, it needs to be updated synchronously.
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10 Diagnostic function

10.1 Operation log

This function can be operated by all users.

Note that the teach pendant provides a log function to view the generated running log.

Steps

1. Select Diagnosis→Run Log from the main menu to display the Run Log window.

Key Description

serial number illustrate

log header Jump to the head of the log

log tail jump to the end of the log

-100 up 100 entries in the log.

100 down 100 entries in the log.

output Output the currently displayed log to a file

refresh refresh current log

filter _ Set log filter display conditions



Welding Process System Instruction Manual

114

picture 10 - 1 Run log

10.1.1 Filters

Description The specified content can be filtered and filtered.

Steps

1. Click the Filter button on the Run Log screen.

2. Set the log content to be displayed.

3. After clicking OK, it will return to the running log interface and display the filtered
log content.
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picture 10 - 2 Run Log - Filter

10.2 Diagnostic data export

The modification permission of this function is set to engineer user and

above.

Steps

1.Plug in the USB flash drive

2.Click on the main menu and select Diagnosis→Diagnostic data export

3. selection path

4.Click the"One-click derivation"button.
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Figure 1 0 - 3 Diagnostic data export
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11 Put into operation

11.1 User tool calibration

The modification permission of this function is set to engineer user and

above.

11.1.1 Four-point calibration of tool coordinates

illustrate

Move the TCP of the tool to be measured from 4 different directions to a reference

point. The reference point can be chosen arbitrarily. The robot controller calculates the

TCP from the different flange position values. The 4 flange positions used for the

movement to the reference point must be separated by a sufficient distance.

Steps

1. In the menu, select Put into Operation→Measure→User Tool Calibration
tool number to be calibrated to set the user tool name.

3. Click the [Start Calibration ] button.
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4. Move to the origin of the base coordinate and click [ Origin ] to obtain the origin

coordinates of the coordinate record.

5. Move to a point of the calibrated reference point 1, and click [ Reference point

1 ] to obtain the coordinate record coordinates.

6. Move to a point of the calibrated reference point 2, and click [ Reference point

2 ] to obtain the coordinate record coordinates.

7. Move to a point of the calibrated reference point 3, click [ reference point 3 ] to
obtain the coordinate record coordinates.

8. Move to a point of the calibrated reference point 4, click [ reference point 4 ] to
obtain the coordinate record coordinates.

9. Click the [Calibration ] button to confirm that the program calculates the
calibration coordinates

10. Click the [ Save ] button to store the calibration value of the tool coordinates

11. Switch to the tool coordinate system, select the calibrated tool number, and
move in the ABC direction, the robot tool TCP will rotate around the workpiece.

picture 11 - 1 Tool Coordinate Calibration
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11.1.1.2 Calibration of tool coordinates by 6-point method

illustrate

Similar to the 4-point method, the 6-point method can calibrate the attitude of the

tool. When recording the point position, the first 4-point method and the 4-point method

mark the same top. When calibrating the 5th point, it is necessary to translate a distance

up along the Z axis on the basis of the 4th point, and record the point. Finally, move

another distance along the X-axis, record the sixth point, and complete the calibration of

the 6-point method.

11.2 User workpiece calibration

This function sets the modification authority to the manufacturer's

personnel user.

11.2.1Workpiece coordinate three-point calibration

Operation steps

1. In the menu, select Start → Measure → User Workpiece Calibration.

2. workpiece number to be calibrated to set the user workpiece name.

3. Click the [Start Calibration ] button.

4. Move to the origin of the base coordinate and click [ Origin ] to obtain the origin
coordinates of the coordinate record.

5. Move to a point in the X direction of the calibration base coordinate, and click
[ X direction ] to obtain the coordinate record coordinates.

6. Move to a point in the Y direction of the calibration base coordinate, and click
[ Y direction ] to obtain the coordinate record coordinates.

7. Click the [Calibration ] button to confirm that the program calculates the
calibration coordinate value

8. Click the [ Save ] button to store the calibration value of the base coordinates

9. Switch to the user coordinate system, select the calibrated workpiece number,
and move in the XYZ direction, it will move in the calibrated direction.
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picture 11 - 2 Base coordinate calibration

11.3 Adjustment function

This function sets the modification authority to the manufacturer's

personnel user.

means that

the axis zero calibration must be performed before the robot runs. The robot can

onlymake Cartesianmovements after zero calibration and move the robot to a safe

position. Themechanical position of the robot and the encoder position are

coordinated during the zero calibration process. To do this, the robot must be placed

in a defined mechanical position, the zero calibrationposition.Then, the encoder return

value for each axis is stored. The calibration positions for all robots are similar, but

not identical. The exact position will also vary between



Welding Process System Instruction Manual

121

robots of the same robot model.

Among them, the calibration function is updated to two types: internal and

external axis calibration and absolute zero point saving. The difference between the

two calibration methods is that, after calibrating the zero point through the internal

and external axis calibration, when a non-zero position is accidentally calibrated to

the zero point during debugging (the zero point position is the calibrated position

after calculating the compensation amount through the latch and professional

equipment), it will cause Need to re-zero calibration; and save the zero point through

the absolute zero point without re-zero calibration, just click to restore the zero

point.

Before the robot is put into operation, it must be calibrated first, otherwise it

will not operate normally.

The robot must be calibrated in the following situations

condition Remark

When therobot isput into

operation

Must be calibrated, otherwise

it will not function properly

robot sends a collision, after

theencodervalue is lost

Must be calibrated, otherwise

it will not function properly

When replacing the motor or

encoder

Must be calibrated, otherwise

it will not function properly

Internal Shaft Calibration Procedure

Steps

1. Click"Menu → Put into Operation → Adjustment → Calibration".
2. Move the robot to the mechanical origin.

3. After each axis moves to the mechanical origin, click each option in the list, an input
box will pop up, enter the correct data and click OK.

4. After the data input of each axis is completed, click to save the calibration data, save
the data, and it will take effect immediately. Whether the save is successful can be
checked by the current actual position data.

External axis calibration steps

1. Click"Menu → Put into Operation → Adjustment → Calibration".
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2. Move the external axis of the robot to the mechanical origin.
3. Click the Send button of [Additional Axis].

4. After the external axis moves to the mechanical origin, click each option in the list, an
input box will pop up, enter the correct data and click OK.

5. After the data input of each axis is completed, click the [Save] button to save the data,
which will take effect immediately. Whether the saving is successful can be checked by
the current position data.

If it shows that the calibration is not successful, please check whether
the network connection is successful;

It can also support single-axis calibration (after calibration, the current
actual position will become the set calibration value, generally a
fixed position fixed calibration value)

Absolute zero point save operation steps

1. Click"Menu → Put into Operation → Adjustment → Calibration".
2. Move the robot to the mechanical origin.

3. After each axis moves to the mechanical origin, click each option in the list, an input
box will pop up, enter the correct data and click OK.

4. After inputting the data of each axis, click the [Calibration] button to save the data,
which will take effect immediately. Whether the saving is successful can be checked by
the current position data and encoder value data.

Restoring zero point save operation steps

1. Click"Menu → Put into Operation → Adjustment → Calibration"
2. Click each option in the list, the input box will pop up, enter the correct data (the same
data as the calibration) and click OK

3. After the data input of each axis is completed, click the [Restore] button, it will take
effect immediately, and whether the recovery is successful can be checked by the
movement back to the zero point.
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picture 11-3 Zero calibration

Note : 1. The mechanical zero position of different models is not the same,

and the calibration value is not the same. You can consult the relevant

technical personnel, and the calibration value is also different at the non-

zero position.

2. After the zero point calibration is completed, the system needs to be

restarted to prevent the zero point loss caused by the system upgrade

without restarting after the calibration.

11.4 Software limit switches

This function sets the modification authority to the manufacturer's

personnel user.

Description By setting the software limit switch, the axis range of all robots and positioning
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axes can be limited.

software limit switch is used for robot protection, and after setting, it can ensure that the

robot runs within the setting range.

software limit switches are set while the industrial robot is running. According to the site

environment, set the corresponding limit for each axis in turn, and the unit of

axis data is radian.

Note : When setting the limit information, the value of the negative limit must be less than

the value of the positive limit.

robot is put into operation, the limit switch must be enabled and the

corresponding axis data must be set, otherwise losses may be caused. The

limits are based on the range of motion derived from the robot's

calibrated zero point, which is a precondition.

Operation steps

1. Click themenuoption,then click"put into operation → software limit switch"in turn

2. Select an axis, edit the limit data in the table, and click Limit Enable [On/Off] to enable
or disable the enable limit.

3. After setting the software limit informationofallaxes,click the [Save] button, and the
settings will take effect immediately.

picture 11-4 Software limit setting



Welding Process System Instruction Manual

125

11.5 Coordination group calibration
Instructions

When the robot shaft group and the external shaft displacement unit perform
cooperative actions, the mutual position relationship between them must be

determined in advance. The process of determining the mutual position relationship is the
calibration between the robot axis group and the external axis group.

Figure 11-5 Collaboration group calibration

Operation procedure

1. Select Put into Operation → Coordinate group calibration from the menu.
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2. Click the Synergy Group Number drop-down box and select the synergy group
number. (This parameter cannot be set arbitrarily. Select the collaborative

configuration group number you just set.)
3. Click the"Collaborative Group Name"input box and enter the annotation of the

collaborative group number.

4, select the" calibration method"drop-down box option, select the 5 point method
(2 external axis coordination use 5 point method calibration, 1 external axis use 3 point
method calibration).

5. Click the"Start calibration"button, obtain the moving robot arm and external axis
in turn, and record the coordinate points (see below for calibration formula).

6, after the record is completed, click the"calibration"button, the calibration result
will pop up.

7. Click [Save] button to complete the collaborative group calibration.

When conducting collaborative calibration, the following conditions must
be met:

The external axis has been zero-calibrated.

sets the external shaft limit.

Calibrates the tool.

Click the [Calibration Result] button to check whether the current

collaboration group number is in use.
must be calibrated in the positive direction of the robot

The calibration steps are as follows:

(1) Determine an arbitrary point (P point) on the turntable of the positioner (the position as
far as possible from the turntable rotation)

Merge the control point of the robot with point P, log in to C1, and record the first point

Figure 11-6 Coordinated 3 - point calibration
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(2) Rotate the positioner shaft by any amount.

There is no limit to the amount of rotation, but please choose more than 30 .

You can choose direction +-.

Merge the controller point of the robot with the selected P point, log in to C2, and record the

second point

picture 11-7 Coordinated 3 - point calibration

(3) Rotate the positioner axis in the direction of rotation in step 2, merge the control point of
the robot with the rotated point P, and log in to C3.

picture 11-8 Coordinated 3-point calibration

If the positioner has two rotation axes, the five-point method is required for calibration:

(1) Determine an arbitrary point (P point) on the turntable (the position as far as possible from
the rotation center of the turntable).

Make the first axis of the positioner axis in a horizontal state with the ground, merge the

controller point of the robot with the P point, log in C1, and record the first point.

。
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picture 11-9 Coordinated 5-point calibration

(2) Rotate the first axis that becomes the machine axis by about 30 , merge the controller
point of the robot with the P point, register C2, and record the second point.

picture 11-10 Coordinated 5-point calibration

(3) Rotate the first axis of the positioner axis by about 30 , merge the control point of the
robot with the P point, register C3, and record the third point.

picture 11-11 Coordinated 5-point calibration

(4) Return to point C1 and rotate the second axis of the positioner axis by about 30 . Merge
the control point of the robot with point P, log in to C4, and record the 4th point.

。

。

。
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Figure 11-12 Coordinated 5-point calibration

(5) Rotate the second axis of the positioner shaft by about 30 . Merge the control point of
the robot with point P, log in to C5, and record the 5th point.

picture 11 -13 Coordinated 5-point calibration

11.6 20-point calibration
Function description

In the case that the accuracy of the tool TCP is high, it can be achieved by using
20-point calibration. The 20-point calibration will mark a high precision tool

coordinate system, but because of the need to maintain high TCP accuracy values, the

Warning:

The zero point will change irreversibly after calibration. You are
advised to select File Calibration File Parameter Management

from the menu to export calibration parameters. Do not operate this
function in other circumstances.

calibration will also modify the zero values of each existing joint.

。
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The 20-point calibration is often used when a collision causes a change in zero
point, which in turn degrades the TCP accuracy of the tool. The 20-point
calibration can be used to calibrate the high precision tool TCP and at the same time

correct and restore the original joint zero value

picture 11 -14 20-point calibration
Operation procedure

1. Select → Put into operation → 20-point calibration from the menu.

2. Select the tool number you want to calibrate.

3. Through the mobile robot, approach the reference point with different

gestures (the difference between the gestures is as large as possible) and obtain the point
position information.
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4. After obtaining more than 10 points, click [Calibration] button, the system will
calculate the offset of zero and the value of the tool coordinate system.

5. Click the [Save] button to save the relevant information.

Tip:

20 points calibration, where 20 points is only an estimate. Usually
only 10 points are needed to complete the calibration, but the more
points are obtained, the more accurate the calibration results are.

20 point calibration is performed to shift the zero points of each
joint, which may cause changes in the actual position of the points
already in the program.

20 point calibration indicates a tool coordinate system with high
accuracy. To ensure high accuracy, it modifies the zero values of each axis
of the system.

12 Help

12.1 Information

Select Help ->Information from the main menu to view the version information of the current

teaching pendant, controller, and robot nameplate in the opened

window.

picture 12-1 Information Display Window
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12.2 System information

Under the authority of engineers or manufacturer personnel

Operation steps:

1. Choose Menu Bar → Help → System Info. The system Info page is displayed.

picture 12 - 2 system information

12.3 Robot Parameters

This feature is available to all users.

Instructions

Robot parameters Used to view system parameters in detail
Operation steps:

1. Choose Menu Bar → Help → Robot Parameters. The robot parameters page is displayed.
2. Click the option drop-down box to display the details of the selected axis parameters.

2.

Figure 12-3 Robot parameters
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13 Systems

13.1 Revelation Teaching Tool

This function can be operated by all users.

Steps

1. In the main menu, select System → Reboot the Tutor, and select"OK"in the pop-up

dialog box to reset the Tutor.

13.2 Clean up the system

This function can be operated by all users.

Explain that this function is used to release the storage space of the controller and clean up

the remaining upgrade package files. When upgrading the system version, you need to clean up

the system first.

Operation steps

1.System in the main menu, and select" OK"in the pop-up dialog box to complete the

cleanup work

13.3 Shut down the system

The modification permission of this function is set to engineer user and

above.

Operation steps

2.1. Openthemenu, click"System → ShutdownSystem"inturn, and select"OK"

in the pop-up dialog box to shut down the controller system.

13.4 Restart the system
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The modification permission of this function is set to engineer user and

above.

Note that this function is used to restart the Type III controller system, which is different

from power-off restart (in some scenarios, power-off and restart mode is required to restart the

system).

Steps

1. In the main menu, select System→Restart the system, and select"OK"in the pop-up

dialog box to restart the controller.

controller

Some settings take effect after restarting the system, such as: load, send

register file, etc.

13.5 System Upgrade

This function sets the modification authority to the manufacturer's

personnel user.

Note In the teach pendant, an upgrade function is provided, which is convenient for users to

upgrade directly on the teach pendant. The suffix of the upgrade file is. tar.gz.

Steps

1. Select System →Upgrade System from the main menu to display the upgrade window.

2. Select the upgraded file.

3. Click Send Update Package.

4. Power off and restart the control system

Before upgrading the system, you need to [Clean up the

system] to free up space
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Figure 13-1 System upgrade

13.6 Authorization

If a controller is used, authorization is required. This function sets the
modification permission to the vendor user.

Instructions

In the new version of the controller software, the licensing function has been added
and the trial time limit has been increased

Figure 13-2 Entitlement
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Operation procedure

1. Choose System > Authorization from the main menu.

2. Insert the USB flash drive and click SN to obtain the sn. A file named sn.txt is
generated on the USB flash drive, which needs to be sent to the company for

registration.

3. Put the registration file genAuthCode into the USB flash drive, insert the
USB flash drive, and click Register to complete the registration.

13.7 Language settings

Steps

1. Select System →language settings

2. Tap the language you want to switch

3. Click“sure"button

Figure 13-3 language settings

14 Welding process package

14.1 Process package management

This function sets the modification authority to the manufacturer's

personnel user.

Explain that the process package management is divided into two parts, one is the installation
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and uninstallation of the process package, and the other is the installation and

uninstallation of the dynamic library.

Steps to install the technology package

1.Open themenu and click"Configuration→TeachPendantConfiguration →Process
Package Management"

2. Click the [ Install Process Package] button, and the U disk file selector will pop
up

3. Select the corresponding file, click OK, and wait for the installation

process package to be successfully prompted that the installation is successful.

Steps to uninstall the technology package:

1.Open themenu and click"Configuration→TeachPendantConfiguration →Process
Package Management"

2 . Select the process package to be uninstalled in the process package list. After

selecting it, click the [Uninstall process package] button and follow the prompts.After the

process package is uninstalled successfully, theprocesspackage information in thisrow in

theprocesspackage listwill be deleted.

Steps to install dynamic library

1.Open themenu and click"Configuration→TeachPendantConfiguration →Process
Package Management"

2. Click the [Install DynamicLibrary] button to popup theU disk file selector

3. Select the corresponding file, clickOK, andwait for the successful installation of the

dynamic library to indicate that the installation is successful.

uninstall the dynamic library :
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1.Open themenu and click"Configuration→TeachPendantConfiguration →Process
Package Management"

2. Select the dynamic library to be uninstalled in the dynamic library list. After

selecting, click the [Uninstall dynamic library] button and follow the prompts. After

the successful uninstallation, the dynamic library information in this row in the dynamic

library listwillbe deleted.

picture 14 -4 Process package management

After the process package is installed, you can enter the related process
package configuration interface in the first-level menu"process
package", which requires a tool U disk.

Explain that the

welding process package is the welding parameter setting module of the welding system,

which can set parameters such as welding machine brand, welding machine working mode,

welding current and voltage.

Steps

Click"Process Package - Welding Process Package" in the first-level menu bar to enter

the welding process package interface.
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14.2Welding package
Instructions:

The welding process package is the welding parameter setting module of the welding system,

which can set the welding machine brand, welding machine working mode, welding current and

voltage and other parameters.

Operation procedure:

Click" Process Package - Welding Process Package"in the first-level menu bar to enter the

welding process package interface

14.2.1 Main interface of welding process system

Open the teach pendant menu: process package -> welding process package, you can enter

the main interface of the welding process system, as shown in Figure 14-1 below:

Figure 14-1 Welding process system interface

System configuration: The system configuration mainly sets the welding machine brand, the

number of welding channels, the brand of the gun cleaning station, the number of arc strikes, and

the working mode of the welding machine.

Welder curve configuration: Set the mapping curve of current and voltage.
Process parameters: Set the process parameters of the welding channel (a total of 10 groups
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of process parameters can be set), including welding machine working mode, arc starting/end

arc voltage/current, welding voltage/current, welding speed, etc.

Output statistics: Count the number of times the specified program runs, that is, the

specified product production quantity.

Authorization: The process package authorization interface, the welding process package

needs to be authorized before it can be used.

Analog correction: The analog correction function is to measure, compare and calibrate the

actual output value and the set value of analog channel 2, so that the actual output value and the

input value tend to be consistent, so as to ensure that the current parameters fed back to the

welding machine are more accurate. precise. This function is only displayed under the

manufacturer personnel user.

14.2.2 Welding system configuration

modification authority of this function is set to engineer users and above,

and production users can only view it.

Open the teach pendant selection menu: Process Package—> Welding Process Package —

>System Configuration; as shown in Figure 14-2 below :

Figure 14-2 Welding system configuration
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It can be seen from the interface that the welding system configuration has 7 configuration

items (as shown in Figure 14-2 ) :

(1) Welding machine brand : At present, O TC, Aotai, Megmeet and Fornis and other
welding machines have been configured.

(2) Welding machine working mode : There are 3 working modes in total, and the common
working modes of analog welding machine are: unification and separate mode.

(3) Welding communication mode: display the current welding machine communication

mode.

(4) Program state restoration after restart: whether to restore the program state after restart
after opening, closing and restarting, and whether to restore the program state after opening, the

programs loaded before restart will be automatically loaded after restart and automatically jump to

the running line before restart, the program state will not be restored after restart after closing, and

the programs loaded before restart will not be automatically loaded after restart. This function is

off by default.

(5) Arc detection switch: The arc detection function can be turned on or off, and the
function is turned on by default.

(6) Arc detection time: Set the arc detection time, the range is 0~ 10S, the default is 4S.

(7) Sticky wire detection switch: You can turn on or off the sticky wire detection function,
which is enabled by default.

(8) Sticky wire detection time: Set the arc detection time, the range is 0~ 1S, the default is

0.3S.

(9) Forward jog wire feeding time：Set the forward jog wire feeding time, with a range of

70-800ms.

(10) Reverse jog wire feeding time：Set the reverse jog wire feeding time, with a range of

100-1000ms.

Note: The welding machine brand, welding work mode, arc detection switch and wire

sticking detection switch in the system configuration will take effect immediately after
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modification. After restarting the system without clicking the"Save Configuration"button,

the previous settings will be restored. After modification, click"Save Configuration"to

restart the system and the last configuration shall prevail.

Click the"Additional function configuration"button to enter the additional function

configuration interface, which can configure the three-color light control switch, LED control

switch, reference point switch, gas flow detection threshold data settings and switches (as

shown in Figure 14-3).

Figure 14-3 Additional function configuration

( 1 ) Tri-color light control switch : It can be turned on and off the tri-color light, the default

is off.

( 2 ) LED control switch : can turn on and off the LED display, the default is off.

(3) Reference point switch: You can turn on or off the reference point judgment

function when the external mode is started. After the operation is changed, you

need to click the save button in the configuration-controller configuration-

running configuration-program configuration according to the prompt to take

effect . This function is enabled by default.
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(4) Gas flow detection threshold: Set the size of gas flow, next to it is a switch, after it is

turned on, it will judge whether there is still gas in the actual arc during the actual welding

process, if there is no gas, the arc will fail and stop welding. The setting range is 0.

1~30L/min.

(5) Arc length and attitude angle proportion detection switch: it can turn on and off the arc

length and attitude angle proportion detection function. When the arc length between the two

adjacent points of the taught arc is smaller than other segments, the attitude change of these

two points should also be smaller than other arc segments. If the attitude change does not

match the arc length, the attitude change speed will be uneven (the terminal speed will not be

affected), and there will be serious jitter, When the program executes to this arc segment, it

will alarm. When off, the length between two points of the arc is not detected. This function

helps to improve arc jitter.

(6) Ratio detection threshold of arc length and attitude angle: set the ratio detection threshold

of arc length and attitude angle. The threshold can be adjusted according to the arc demand of

teaching welding section. The greater the threshold, the more stable the arc running of

successful teaching. The setting range is 0~ 1.

14.2.3 Welder curve configuration

modification authority of this function is set to engineer users and above,

and production users can only view it.

14.2.3.1Welding voltage curve configuration

The curves corresponding to different welding machine brands are different. Enter the

welding curve configuration page and click"Welding Voltage"below to configure the input and

output curves ofthe welding machine voltage, as shown in Figure 14-4 :

The specific operations are:
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1 ) If you know the minimum and maximum voltage of the welding machine, you can directly fill

in the voltage range value into the input box, otherwise follow steps 2 to 5 to test to obtain the

output voltage curve of the welding machine

2) Enter the voltage value in the input box on the right side of the analog A O1 (range: 0~ 10, it is
recommended to start from 0, gradually increase and test), click"Enable",

3 ) Observe the display value of the welding machine voltage, whether it is the minimum value, if

so, change the value ofA O1, repeat the operation of step 2, until the minimum voltage value of

the welding machine panel changes, remember the value of A O1 at this time and fill in In the

output voltage input box,

4 ) Enter a voltage value in the input box on the right side of the analog A O1 (range: 0~ 10, it is
recommended to start from 10, gradually reduce and test), click"Enable",

5 ) Repeat steps 3 and 4 until the maximum voltage value of the welding machine changes,
remember the value ofA 01 at this time and fill in the output voltage box

6 ) Verify whether the output voltage curve is correct. In the welding machine value test input box,

enter the welding machine voltage value to be tested, and observe whether the deviation between

the voltage value displayed on the welding machine panel and the input value (theoretical value) is

within the allowable range ( The maximum deviation of voltage and voltage is 1% of full scale), if

the deviation is too large, reconfigure according to steps 1~ 5.
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Figure 14-4 Welder Curve Configuration

14.2.3.2Welding current curve configuration

Refer to 14.2.3. 1 Welding voltage curve configuration process to configure

14.2.3.3 Unary curve configuration

The analog communication welding machine needs to switch to the unary mode on the

welding machine panel first, and then configure it according to 14.2 .3 . 1 welding voltage

curve configuration process.

14.2.4 Process parameters

modification authority of this function is set to engineer users and above,

and production users can only view it.

Enter the welding process package process parameter setting interface as shown

in Figure 14-5, which is mainly divided into message prompt area, menu selection area,

content display, and button operation area.

Menu selection area

Content display

Button operation

area

Message

prompt area
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Figure 14-5 Process parameter setting interface

（1） The message prompt area is to display the feedback of the

setting information, such as whether the setting is successful after setting the

parameters, whether the deletion is successful after the channel is deleted,

and so on.

（2） The menu selection area is to choose to enter different setting

interfaces. The menu selection area includes welding channel and weaving
welding channel. Back-arc waiting time,

terminal welding time, welding voltage, welding current, robot

magnification, welding speed and other process parameters.

(3 ) The display area is the main area for displaying welding information.

(4) button operation area includes the modify, copy, delete, undo
and clear buttons of the welding channel and the weaving channel setting
interface.

14.2.4.1Welding channel

Welding channel is a group of data saved after setting welding parameters, the
number of

channels can be configured, up to 30. After the welding channel is set, it can be called by the

program.Open the teach pendant selection menu: process package -> welding process package

-> process parameters -> welding channel ; the parameters that can be set in the welding

channel mainly include: welding machine working mode, arc starting voltage, arc starting

current, arc ending parameters, closing arc parameters Arc current, waiting time after arc

strike, terminal welding time, welding voltage, welding current, robot speed, retraction time, etc.

11 items, as shown in Figure 14-6 below ;

Figure 14-6 Welding channel process parameters



Welding Process System Instruction Manual

147

Channel number: the number of a group of process parameters (1~ 10 )

Welder working mode: Generally, there are 8 working modes of welding machine, and there

are 2 working modes available for analog welding machine: separate and unified

Arc start voltage: the voltage of the welding machine in the arc start stage

Arc starting current: the current of the welding machine in the arc starting stage

Crater voltage: the voltage of the welding machine in the crater stage

Crater current: the current of the welding machine in the crater stage

Waiting time after arc striking: the time the robot stays at the arc striking point after the arc

striking is successful

Terminal welding time: the time the robot stays at the welding end point

Welding voltage: the voltage of the welding machine in the welding stage

Welding current: the current of the welding machine in the welding stage

Welding speed: The welding speed of the robot during the welding phase

Retraction time: the time for wire retraction
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14.2.4.2Modification

Steps for welding pass modification:

（1） Select the row to be modified;

（2） Click the"Modify"button below the channel list, and the channel

modification dialog box shown in Figure 14-7 will pop up;

Figure 14-7 Weld channel modification dialog box

In the modification dialog box, the current parameter value is displayed by default.

The welding machine working mode is an optional item, and the others are input values.

Enter a certain value to be modified.

(3) Click"OK"to complete the modification.

14.2.4.3 Replication

Steps for channel duplication:

（1） Click the"Copy"button below the channel list, and the channel copy dialog box

shown in Figure 14-8 will appear;
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Figure 14-8 Channel copy function

（2） The channel copy dialog box includes the source channel number and the target

channel number. Enter the line number to be copied in the edit box after the source channel

number, and enter the line number of the line copied to the target channel number;

(3) Click the"OK"button to execute the channel copy operation;

14.2.4.4 Delete

（1） Select the row to delete;

（2） Click the"Delete"button below the channel list;

(3) Figure 14-9 pops up the prompt box ofwhether to delete the channel, click
the"OK"button to execute the delete operation;

Figure 14-9 Delete channel prompt box

14.2.4.5 Revocation

The function of the undo operation is to undo the last modification, copy or delete operation,

and the undo operation is only valid for the latest operation. After clicking cancel, it will take

effect immediately.

14.2.4.6 Clear

Empty is to delete the data of all channels.
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Steps to clear the channel:

（1） Click the"Clear"button under the channel list, and the following dialog box

will pop up

Figure 1 4-10 Whether to clear the channel prompt box

（2） Click the"OK"button to clear the channel;

14.2.4.7Weaving channel

Weaving welding channel is a set of data saved after setting welding parameters. The number

of channels can be configured, up to 10. After the weaving welding channel is set, it can be called

by the program.

Open the teach pendant selection menu: Process Package—> Welding Process Package—>

Process Parameters—> Weaving Weaving Channel ; the parameters that can be set in the weaving

welding channel mainly include: swing track type, swing shape, swing frequency, swing amplitude,

swing plane, Whether to stay, left stay time, right stay time and other 8 items, as shown in

Figure 14-11 below ;

Figure 14-11 Weaving welding channel

For the related operations of the weaving welding channel, refer to the welding channel.

Note: The speed of weaving welding divided by the frequency needs to be greater than or

equal to 2.5. 2.5 is the best. Before using weaving welding, you must use the 6-point method to
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calibrate the tool coordinates. For detailed steps, refer to the calibration of tool/workpiece

coordinates.

Weaving welding channel parameter reference table

serial

numbe

r

Whether there is

Weaving welding

speed ( mm/s)

Weaving

welding

maximum

acceleration

Weaving

welding

maximum

deceleration D

EC

C NT

any

change

attitude

at the

starting point and

end point of

weaving welding

1 have 6 0 6 00 6 00 1 00

2 4 0 1 500 1 500 1 00

3 3 0 3 000 3 000 1 00

4 without 6 0 6 00 6 00 1 00

5 3 0 1 500 1 500 1 00

6 20 3 000 3 000 1 00

Description of table content:

No. 1, when there is no attitude change at the starting point and end point of the weaving

welding, the maximum speed of the weaving welding is within 60mm/s, and the acceleration and

deceleration can be set to a maximum of 600 ;

No. 2, when there is no attitude change at the starting point and end point of the weaving

welding, the maximum speed of the weaving welding is within 40mm/s, and the acceleration and

deceleration can be set to a maximum of 1500 ;

No. 3, when there is no attitude change at the starting point and end point of the weaving

welding, the maximum speed of the weaving welding is within 30mm/s, and the acceleration and

deceleration can be set to a maximum of 3000 ;

No. 4, when the starting point and end point of weaving welding have attitude changes, the

maximum speed of weaving welding is within 60mm/s, and the acceleration and deceleration can

be set to a maximum of 600 ;

No. 5, when there is a change in the attitude of the starting point and the end point of the

weaving welding, the maximum speed of the weaving welding is within 30mm/s, and the

acceleration and deceleration can be set to a maximum of 1500 ;

No. 6, when there is a change in the attitude of the starting point and the end point of the

weaving welding, the maximum speed of the weaving welding is within 20mm/s, and the

acceleration and deceleration can be set to a maximum of 3000 ;
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14.2.5 Production statistics

This function can be operated by all users.

Open the teach pendant selection menu: Process Package—> Welding Process Package— >

Production Statistics ; as shown in Figure 14-12 below :

Figure 14-12 Yield statistics function

1. After adding the output statistics command in the program, turn on the switch of the
current station (green is on, gray is off), and the number of times the current station is running will
be counted, that is, the number of production.

2. Click the clear button, a prompt dialog box will pop up, asking whether to clear the output
of the current station, click the OK button to clear the output of the current station.
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14.2.6 Runtime statistics

modification authority of this function is set to engineer users and above,

and production users can only view it.

Open the teach pendant selection menu: Process Package—> Welding Process Package— >

Running Time Statistics ; as shown in Figure 14-13 below :

Figure 14-13 Running time statistics function

1. Click the reset button, a prompt dialog box will pop up, asking to confirm the reset time,

click the OK button to reset the current time.

14.2.7 Process system license

modification authority of this function is set to the manufacturer personnel

user, and the production personnel and engineer users can only view it.

Note: Welding process system requires separate authorization
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Figure 14-14 Authorization function

Steps:

(1) In the main menu, select Configuration -> Process Package -> Welding Process Package
-> Authorization.

(2) Insert the U disk and click to get the SN. At this time, a file named XX-XX-XX

-XX-XX-XXsn_threesolder is generated in the U disk. This file needs to be sent to the co

mpany for registration, where X X is the system S N. _

(3) Put the registration file XX-XX-XX-XX-XX-XXgenThreeArcAuthcode into the U disk,

insert the U disk, and click Register to complete the registration.

14.2.8 Analog correction

modification authority of this function is set to the manufacturer's

personnel user, and it is only displayed under the manufacturer's personnel

user.

Explain that the analog correction function is to measure, compare and calibrate the actual

output value and the set value of the analog channel 2, so that the actual output value and the input
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value tend to be consistent, so as to ensure that the final current parameter fed back to the welding

machine is more accurate;

Steps:

1. After logging in to the manufacturer's user, the main interface of the process package will
display the" Analog Correction"function button, click this button to enter the analog correction
interface.

2. Select the serial number 1 in the correction interface, then click the delete button on the
right to clear all parameters, and then click the" Save"and" Download"buttons to initialize the
data;

3.After there is no data, select the correction switch to open the correction function (as shown
in Figure 14-

2. .

Figure 14-15 Analog correction switch

4. Click the" Add"button on the right, enter the setting value in the pop-up input box

and click to take effect, measure the actual output value of the current channel with a

multimeter, fill in the actual value, and click OK. Because the range of analog quantity is

0.00V-10.00V, it is required to take about 100 points (0.05, 0.15, 0.25....9.85, 9.95) evenly for

calibration to ensure accuracy and retain two decimal places after the decimal point. The set

value and the measured value cannot exceed 10.00V. After the correction value is added,

click the"Save"and"Download"buttons.
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14.2.9 Welding status

This function can be operated by all users.

Display the current welding function parameter status and process parameter data under bus
communication.

Figure 14-17 Function Parameter Status

Figure 14-18 Process parameter data
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14.3 Torque sensor calibration process package

Figure 14-19Torque sensor process package main interface

The process package is only applicable to version V1.6. 11 and the robot has been

dynamically identified.

Calibrate the new adaptive sensor, change the sensor installation mode, and change the end

load. After the calibration, calibrate the sensor each time.

14.3.1 Sensor calibration

Sensor calibration process:

1 Switch the tool job number in the upper right corner of the demonstrator to default;

2 Switch the load number in the upper right corner of the demonstrator to no-load, and
select the load number of the process package that needs to be calibrated;

3 Make sure that the load number of the calibration interface is consistent with the selected
load number;
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4 Set the motion range of each axis;

5 Click on trial run;

6 Click to start identification, the robot runs the program at this time, and needs to wait for
the program to finish;

7 Click to return;

8 Click to calibrate;

9 Sensor calibration and calibration completed;

Figure 14-20 Sensor calibration
The front page of the process package displays the current load number, sensor external force

value based on the current calibration parameters, calibration and calibration buttons. The

calibration button is used when the sensor has been calibrated, and the calibrated sensor is used

with zero drift (note: each time the machine is powered on and restarted, the sensor needs to be

calibrated); The calibration button is used when the sensor is not calibrated, the sensor installation

mode or the end load changes. In these cases, the sensor needs to be re-calibrated. The calibration

parameters are bound to the load number and are automatically saved.

14.3.2 Sensor calibration

Select Process Package → Torque Sensor Calibration → Calibration from the main menu

Instructions：

1. Re-calibration is required after the end load changes.

2. If there is no display of TCP torque at the end, it indicates that [calibration] has not been
performed under this number, please perform [calibration] operation;；



Welding Process System Instruction Manual

159

3. After switching the load number, turn on the drag switch again to confirm that the drag
is safe.

4. Do not touch the robot during calibration.

Operation procedure：

Figure 14-21 Operation procedure

14.3.3 Drag the teach Settings

From the main menu, select Configuration → Dynamics → Drag to teach Settings

Operation procedure: as shown in the figure

Figure 14-22 Drag the teach Settings



Welding Process System Instruction Manual

160

14.4 Drag button

Drag two modes:

Quick drag: Long press the flexible drag button without releasing, and the robot can be

dragged.

Precision drag: Long press the flexible drag button without releasing, press the precision

drag button once, you can switch to precision drag.
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14.4.1 Quick programming key

There are eight keys in total. The mapping between DI and DI is lower：

Function description Corresponding DI signal

KS DI12

JS DI13

BH DI14

DC DI15

J DI16

L DI17

A DI18

X DI19

When the instructor switches to manual mode, that is, T1 or T2 mode, open the program editing

interface.

1. Press the"KS"button, the DI13 signal is connected, if the DI13 rising edge is detected,
the"Arcing"command will be inserted.

2. Press the" JS"button, the DI13 signal is connected, if the DI13 rising edge is detected,
the" Arc Off"command will be inserted.

3. Press the" B H "button, DI14 signal is connected, then press the"KS/"button," swing



Welding Process System Instruction Manual

162

welding start"command and"Arcing"command will be inserted at the same time.

4."DC"button, DI15 Considering the problem of template application, need to supplement the
explanation, reserved. (Currently not in effect)

5. Press the" J"button, DI16 signal is switched on, if the DI16 rising edge is detected, insert
the" joint"command and record the current robot point position.

6. Press the"L"button, DI17 signal is connected, if the DI17 rising edge is detected, insert
the"straight line"command and record the current robot point position.

7. Press the" A"button, DI18 signal is connected, if the DI18 rising edge is detected, insert
the"arc"command and record the current robot point position.

8. X：Reserve.
Program example：

15 Program files

15.1 Program file management navigator

Explains that

the user can manage programs and all system-related files in the navigator.
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header row

Left area: Displays the selected folder.

Right area: Displays the files under the selected directory in the directory structure.

([Open] button can open the corresponding folder)

Directory Structure

Catalog overview. Which directory is displayed, click to display the directory list.

File List

Displays the contents of directories marked in the directory structure.

Figure 1 5-1 Navigator interface

15.2 New

The modification permission of this function is set to engineer user and

above.

Steps

1. Select the folder in the directory structure where you want to create the file

2. Click New
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3. Select a program or folder

4. Give a name for the new file (name cannot contain spaces) and press the"OK"button.

Figure 1 5-2 New program or folder

15.3 File / folder deletion

The modification permission of this function is set to engineer user and

above.

Actions Mark files or folders in a directory structure.

Choose Edit→Delete. (file is not locked)

Click the Confirm button in the dialog box, and the marked file or folder

will be removed.

15.4 Selecting a program

This function can be operated by all users.

Overview A program can be selected or opened. A program editor will then be

displayed instead of the navigator. You can switch back and forth between the

program display and the navigator.

15.5 Open and close programs

This function can be operated by all users.
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Steps

1. Select the program in the Navigator and click the"Open"button.

2. The program will appear in the editor. The selected program will open to the editor.
The corresponding open file is always displayed in the editor. At the same time, the run
cursor is displayed.

3. Close the program: select"More → Close Program"or directly press the"Close"

button. If a program is running, it must be stopped before canceling the program selection.

15.6 Locking and Unlocking of Files

The modification permission of this function is set to engineer user and

above.

Operation steps File lock:

5.Mark files in a directory structure.
6.Select Edit→Lock, and click the"Lock"button in the prompt box.
7.Once locked, the selected file icon will display a lock style.

Unlock:
1.Select the locked file in the file directory.

2. Select Edit→Lock, and click the"Unlock"button in the prompt box.
3. Enter the unlock password and click OK to unlock the currently

selected file.
The initial password for unlocking is"hspad".

Change the unlock password:
1. Select File→Lock Password Settings from the main menu.
2. After entering the original password and new password, click

the"OK"button to save the new password.

Locking can only be performed on files, not on folders.

Rename, delete, and open operations cannot be performed on locked files.

Figure 1 5-3 Setting the lock password
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16 Teach run

16.1 Action mode

teach mode : incremental and continuous.

16.1.1 Continuous

This function can be operated by all users.

Operation steps

1. Select the coordinate system of"run key"in teaching mode

2. Set the teaching override.

The following names appear next to the run key:

A1 -A6 : corresponding to the axis number marked on the robot;

X, Y, Z: used for linear motion along the axis of the selected coordinate system;

A, B, C: For rotary motion along the axis of the selected coordinate system.

3. Press and hold the safety switch with the enable on.

4. Press the plus or minus run key to move the robot in the plus or minus direction.

The position of the robot during motion can be displayed by the
following methods:

Select Main Menu→Display→Actual Position. For the first time, the
Cartesian coordinate position is displayed by default. If the axis
coordinate is displayed, you can click the Cartesian button on the
right to switch.

16.1.2 Incremental

modification permission of this function is set to engineer user and above.

illustrate

Incremental teach mode allows the robot to move a defined distance, eg 10 mm or 3

。.Then the robot stops by itself, or 0 ~ 10°/0~ 100mm custom inching distance.

Application range:

1. Position the points at the same distance
2. Move a defined distance from a position
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3. Use the measuring table to adjust
The following options are available

set up illustrate

continuous Incremental teach movement is turned off.

100mm/10 ° 1 increment = 100 mm or 10 °

10mm/3 ° 1 increment = 10 mm or 3 °

1mm/1 ° 1 increment = 1 mm or 1 °

0. 1mm/0.005 ° 1 increment = 0. 1mm or 0.005 °

mm : for Cartesian motion

Spend : for axis-related motions

If the movement of the robot is interrupted, eg by releasing the safety

switch, in the next action

The interrupted increment is not continued, but a new increment is started
from the current position.

picture 16 - 1 Incremental teach move

16.2 Teaching magnification

This function can be operated by all users.

Note that the magnification is the speed of the robot at runtime. It is expressed as a
percentage.

Steps
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1. Touch the magnification adjustment status icon to open the magnification adjustment
amount window, and the magnification will be adjusted after pressing the corresponding
button or dragging.

2. The desired teaching magnification can be set by the positive and negative keys or by
the screen adjuster

negative keys : can be set in 100%, 75%, 50%, 30%, 10%, 3%, 1% steps

Adjuster : It can be set in 1% steps.

【Remarks】Only the teaching magnification can be adjusted in the teaching mode; only the

automatic magnification can be adjusted in the automatic mode.

Figure 16 - 2 Teaching magnification display and adjustment

16.3 Tool selection and workpiece selection

modification permission of this function is set to engineer user and above.

Description Up to 16 tool coordinate systems and 16 workpiece coordinate systems can be

stored in the robot control system.
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picture 16 - 3 Tool Workpiece Coordinate System

Steps

1. Touch the Tool and Workpiece Coordinates status icon to open the Active
Tool/Workpiece Coordinates window.

2. Select the desired tool and desired workpiece coordinates.

Remarks :

Before loading the program, the current actual position is displayed based on the tool

workpiece selected by the user. After the program is loaded (not running) successfully, the

display of the tool workpiece coordinate system is the default, regardless of the non-

default tool workpiece coordinate system selected before loading. After running the

program, the tool workpiece coordinate system will be displayed according to the

tool

workpiece coordinate system called in the program. If it is not called, the default tool

workpiece coordinate systemwill be used and displayed. When the program is unloaded, it

will be restored to the tool workpiece number called before loading.

Taking the currently used tool workpiece coordinate system shown
above as the standard, the current actual position is displayed.

16.4 Movement to the point

This function can be operated by all users.

AUCTECH III control system provides the function of moving to the point, select the

JR/LR variable in the main menu display → variable list, click" Change", enter the target

coordinates,
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press the safety switch, and click" Joint to point"or"Linear"To the point", you can run the robot to

the target point. If it is the program editing interface, select the motion command line, press the

safety switch, and click" joint to point"or"line to point"to achieve this function.

【Remark】

The arc command does not support the movement to point function.

Note: Cartesian coordinate LR, because there are different shape positions,

is not teaching" acquisition coordinates". The input coordinates need to be

confirmed after teaching, and then the shape position can be generated

before moving to the point correctly.
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17 Autorun

This function can be operated by all users.

Steps

1. Select the mode to be run : teach /automatic mode

2. Select the program to be run in the navigator interface and click"Load"

3. In teaching mode, press the safety switch, and do not release it during the program
running; in automatic mode, click the enable button on the upper left of the screen to
turn on the enable.

4. Adjust the speed magnification to an appropriate value.

5. After the program is displayed on the teach pendant as" ready", click the physical run

button on the left side of the teach pendant to start the program (for the function of the

left physical button, please refer to Section 4. 1 AUCTECH Type III Teach Pendant -

Front View )

6. When the program is running, click the corresponding physical button to pause and
stop the program.

【Remark】

1. It is not allowed to switch modes while the program is running

2. Program editing is not allowed during program loading /running
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18 Emergency stop

This function can be operated by all users.

The emergency stop switch is used in an emergency to stop the robot movement in an

emergency. Located on the top right of the teach pendant (red button).

Steps

1. In the event of an emergency, take a photo of the emergency stop button on the upper
right of the teach pendant

2. Turn the emergency stop button clockwise to release the emergency stop switch

3. In the status display window of the teach pendant, click"Alarm Confirmation"to clear
the emergency stop error
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19 Jump function

This function can be operated by all users.

Note In the teaching mode, the program supports jump running. If the program pointer is

jumped to the selected row and then run, it will be executed sequentially from the selected row.

Steps

1. In teaching mode, load a program and enable teaching

2. Select any line of instructions in the program, click the"Run"button, the running pointer of
the program running interface jumps to the selected line

3. Click the"Run"button again, and the program will execute the current command. If the

current running mode is single-step running, after executing this line of instructions, the running

pointer will point to the next line of instructions; if the current running mode is continuous

running, the running will be completed. After the current instruction, the program will continue to

execute downward until the program is completed.

The jump function can be used in conjunction with the back function.

When backing up, only the motion command is executed, and other
commands are ignored and not executed.
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20 Button functions

20.1 Use of welding function keys

This function can be operated by all users.

20.1.1 Welding button introduction

In the upper right part of the teach pendant, there are 12 buttons to control the movement of

the robot. In the welding system, these 12 buttons are reused when not enabled. From top to

bottom, each row of buttons corresponds to 7 functions of program operation mode switching and

coordinate system switching button, welding switch, collision cancellation, gas detection, wire

feeding control, wire feeding magnification, and search and replacement. The second row of

buttons is in In the teaching mode, it is the program operation mode switching and coordinate

system switching buttons, and in the automatic and external modes, it is the welding switch. The

specific distribution is shown in Figure 20-1 :
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Figure 20-1 Function keys

20.1.2 Welding button function introduction

（1） Collision release: When the robot collides, press the corresponding"+"key, the switch is

turned on, the collision signal is released, and there is 15 time to move the robot away from

the collision point. After the timeout, the collision release switch is automatically turned

off, if you need to remove the robot, you need to turn this switch on again. If the operation

is completed within the time range, press the corresponding"-"key to close the collision

cancellation.

（2） Welding switch: The welding switch is the main switch for controlling welding. This

switch will only be displayed in the automatic mode, and will be automatically turned off

in the teaching mode. When this switch is turned off, welding-related functions cannot be

used. The corresponding operation is: press the"+"key to open, and press the"-"key to

close.

(3) Gas detection: Press the"+"key to open the gas valve. Press the"-"key to close the air
valve.

(4) Wire feed control :
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A. Press the"+"key under the physical button to feed the wire forward, press and release it
within a certain period of time for forward jog wire feeding, and release it after a certain

period of time for forward continuous wire feeding. will stop feeding. Press the"-"key to

reverse the wire feeding, press and release it within a certain period of time for reverse jog

wire feeding, press and release it after a certain period of time for reverse continuous wire

feeding, and the wire feeding will stop after releasing. The time can be set in the

technology package system configuration.

B. In the teaching mode, turn on the enable and display the jog wire feed button below the

axis, click the"wire feed +"button to realize the forward jog wire feeding, and click the

"wire feed -"button to realize the reverse pull jog wire feeding (such as Figure 20-2 ). The

wire feeding length is controlled by the wire feeding ratio.

Figure 20-2 Enable lower wire feed button

（5） Wire feed rate: 10%-100% when the wire feed rate is adjusted. Press the"+"key to

increase the wire feed rate by 10%. Press the"-"key to reduce the wire feed rate by 10%.

The speed takes effect immediately.

（6） Find and replace: The command line attribute can be replaced when editing the program.

This function is only used when replacing the command attribute.

(7 ) Program running mode switching and coordinate system switching keys: Press

the"+"key to switch the coordinate system, switch between the axis coordinate system

and the user coordinate system. Press the"-"key to switch the program running mode,

switch

between continuous and single step.

20.2 Debug button for program single-step continuous running

This function can be operated by all users.
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20.2.1 Single-step program key

After switching to the single step mode and enabling, the first row of keys of the axis keys

are for the program to step backward and the program to step forward. Press the" -"key to step

backward and execute one step program. After release, the program stops running. Press

the" +"key to step forward and execute one step program. After release, the program stops running.

Figure 20-3 Button single-step running program

20.2.2 Continuous running program key

After switching to the single-step mode, the second row of keys ofthe axis keys has the

functions of continuous backward running program and continuous forward running program.

Keep pressing the"-"button and the program will continue to execute backward. After releasing,

the program will stop running. Hold down the"+"key and the program will continue to execute,

and the program will pause immediately after releasing it.

Figure 20-4 Press the button to run the program continuously

20.3 Instruction shortcut insert button
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The modification permission of this function is set to engineer user and

above.

Instruction shortcut insertion can use the button to insert instructions. This function can only

be operated after the teaching mode starts to edit. After clicking the" Start Editing"button in the

program editing interface, the upper left button of the teach pendant becomes the shortcut

insertion instruction button (as shown in Figure 20- 5).

The first button is to switch the type of motion command inserted, and there are three kinds

of motion command switching: joint, straight line, and arc.

The second key is the insert motion command key, which inserts the command type selected

by the previous key.

The third button is the button for inserting the arc starting command. Click the button to

insert the arc starting command, and click the icon to select the inserted arc starting channel

number.

The fourth button is the insert arc crater command button. After pressing, the arc crater

command is inserted, and the arc crater command channel number is consistent with the selected

arc starting channel number.
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Figure 20-5 Shortcut key insertion command

After selecting any line of the program, press the shortcut key, and the corresponding

command will be generated in this line as shown in the figure.

20.4 Program shortcut sliding button

After loading the program, you can use the program shortcut sliding button to slide the

program line. The program shortcut sliding button is on the seventh row of buttons on the right

side of the teach pendant. Press the" -"button to slide the program up, release it to stop sliding,

and press"+". Press the key to slide down the program, release it to stop sliding, this function can

improve the debugging efficiency when debugging the program.
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20-6 Program sliding key

20.5 Remote reservation function

This function can be operated by all users.

20.5.1 Functional Description

The remote reservation function is a function added based on the external mode for
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single-machine multi-station production. The function of this function is to record the status of the

station's production preparation, and directly go to the next station after completing the production

of the previous station. The worker does not need to wait for the previous station to finish

production before pressing the next station. bit start button. This function currently supports

appointments for up to eight workstations.

20.5.2 Usage process

（1） Configure the reservation switch on the standby button, as shown in Figure 20-7 :

Figure 20-7 Reservation switch

（2） Turn on the appointment switch, switch the mode to external mode, and configure

the external startup program. (For external program configuration, please refer to the

instruction manual of AUCTECH Ⅲ teach pendant)

(3) Press and hold the start position for two seconds at the station where the workpiece is
installed to complete the station reservation operation.

(4) Press the reservation switch again to cancel all reservations.
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21 Welding system coordination function

21.1 Configure the collaboration group number

This function sets the modification authority to the manufacturer's

personnel user.

HSPad software menu, select the configuration-controller configuration-cooperative

configuration page as shown in Figure 21-1:

Figure 21-1 Collaboration configuration page

It can be seen from the figure that the configurable parameters are the coordination

group number, the logical axis number, and the axis type.

Thecooperativegroupnumber is stored in thewayofexternalaxisconfiguration.

The logical axis number refers to which axis the external axis is in the robot axis group.

Theaxis typerefers tohow theaxismoves, currentlyonlyrotation is supported.

Herewe select the collaboration group number as 0 , and click theModify button

in the row of axis number 0, as shown in Figure 21-2 :

Figure 21-2 _

At this time, click Unconfigured to select the axis number and axis type. Here we choose 7
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axes, and the rotation type is shown in Figure 21-3 :

Figure 21-3 _

After completion, click Save in the lower right corner to complete the configuration of

the first synergy axis. Formulti-axis collaboration, the method is the same.

Note:When there is flip and rotation, youneed to configure the flipaxis first, and then configure

the rotation axis.

21.2Collaborative teaching

The modification permission of this function is set to engineer user and

above.

Note After the collaborative calibration is completed, you can select the base label/tool pop-up

box in the teaching mode to select the calibrated collaboration group, and then click

the"Collaboration"button. After the collaboration button turns green, enable it and select

the additional axis. Afterwards, coordinated movements can be performed. Collaborative

teaching can also be performed by creating a new collaborative group program file.

Teaching steps when the program is not open :

（1）Click the" Select Base Icon/Tool" icon at the top of the software, and the"Select Base

Icon/Tool"pop-up box will appear after clicking.
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picture 21 -1 3 Collaborative group selection

（2）In the pop-up box, click and click the collaboration group selection drop-down box,
and then select the collaboration group that needs to be coordinated.

(3) After the selection is completed, the"Collaboration"button will be displayed. Click
the"Collaboration"button. The effective collaboration group at this time is the selected
collaboration group. The button turns green to enable collaboration, and gray to close
collaboration.
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picture 21 -1 4 Collaboration button

(4) After enabling it, select the additional axis motion, and the external axis configured by

the coordination group will be displayed at this time. Press the corresponding axis button on the

right to perform the coordinated motion.

Teaching steps for creating and opening coroutines:

（1）When creating a new program, select the calibrated coordination group coordinate

system, and click OK (as shown in the figure below).

Figure 21-13 Create a new coroutine



Welding Process System Instruction Manual

186

(2) After creating a new program, open the program, and when inserting a point that needs to be

coordinated, click the"Coordinate"button to insert the motion commands of line, arc, linear

weaving, circular arc weaving, linear fish scale welding, and arc fish scale welding. The

point is automatically defaulted to be the coordinated motion point (as shown in the figure

below).

Figure 21-15 Collaboration properties

( 3 ) After opening the collaborative program, the"Collaboration"buttonwill be displayed, click

the"Collaboration"button, the effective collaborative group at this time is the collaborative group

bound by the program, the button turns green to open the collaboration, and the gray state

means to close the collaboration.

(4) After opening the collaborative program and clicking the" Start Editing"button, the first
button of the auxiliary button is changed to the collaborative attribute button (as shown in Figure
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8). Line, arc, linear weaving, arc weaving motion, linear fish scale welding, arc fish scale welding

motion commands without synergy attribute will automatically increase the synergy attribute, if

there is synergy attribute, cancel the synergy attribute of the current command. Reverts to user-

configured key functions when exiting editing.

Figure 21-16 Collaboration attribute button
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22 Asynchronous axis function

22.1 Asynchronous axis control mode configuration

This function sets the modification authority to the manufacturer's

personnel user.

In the HSPad software menu, select Configuration - Controller Configuration - Axis Group

Configuration, click the Modify button in the control mode, select the asynchronous axis mode,

click Modify in the number of additional axes, and enter the number of additional axes (as shown

in Figure 22-1). ), and then power off and restart the controller according to the prompts.

Figure 22-1 Asynchronous axis control mode configuration

22.2 Asynchronous axis parameter configuration

This function sets the modification authority to the manufacturer's

personnel user.

In the Hspad software menu, select Configuration-Teach Pendant Configuration-User Group,

select the parameter person user login in the login interface, and log in to enter the welding

process package system configuration. Click the positioner configuration button to enter the

parameter configuration interface, and you can configure the deceleration of additional axes. ratio,

acceleration time, deceleration time, running speed, and maximum running speed. Click to save

the parameters after the input is complete.



Welding Process System Instruction Manual

189

22.3 Unsynchronized axis motion

This function can be operated by all users.

After the parameter configuration is completed, it is necessary to select Operation -

Adjustment - Calibration in the Hspad software menu, click the additional axis button on the axis

calibration interface to enter the additional axis calibration interface, and click to save the

calibration.

After calibration, click the axis icon on the right side of the teach pendant, and select the

additional axis in the pop-up list box. At this time, the icon on the right button is the icon of the

additional axis. First turn on an additional axis switch, and then press the corresponding additional

axis. Press the motion button to move the additional axis. You can select Display - Actual Position

in the Hspad software menu to see the actual position of the additional axis at this time.

22.4 Asynchronous axis motion command

The modification permission of this function is set to engineer user and

above.

Calling the additional axis command in the program will record the current position of the

additional axis to make the additional axis move, open a program, click the system command -

motion command - additional axis running command to add an additional axis motion command,

only after the additional axis switch is turned on. The position of the additional axis that is turned

on will be recorded, and the current position of the additional axis that is turned off will not be

recorded.
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Figure 22-4 Additional axis motion command
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23 PRG program structure and
program editing

AUCTECH III control system has only one program for users: PRG file, which

supports PRG program to call other PRG programs, that is, the caller is [main program],

and the callee is [subroutine].

23.1 Program structure

The program is divided into three modules: axis initialization, variable declaration and

main program, the structure is as follows.

attr

VERSION:0

GROUP:[0]

end

pos

P[1]{GP:0,UF:-1,UT:-1,JNT:[-0.0, -89.998, 180.001, 0.001,
89.994, 0.001, 0.0, 0.0, 0.0]};

Define coordinate
variables

P[2]{GP:0,UF:-1,UT:-1,CFG:[0, 0, 0, 0, 0, 1],LOC:[286.522, -
0.0, 232.473, 179.999, 0.0, 179.999, 0.0, 0.0, 0.0]};

end

Bind business layer

and axis group

and declare variables
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<program>

LBL[1]

J P[1] VEL=50

L P[2] VEL=50

GOTO LBL[1]

<end>

The above coordinate variable has a custom coordinate type P point, and the joint coordinate

JR of the register, and the Cartesian coordinate LR;

23.1.1 Coordinate types

Define a variable P[1] point, joint coordinate, the meaning is as follows:

GP: axis group, UF:

work piece number, UT: tool

number

P[1]{GP:0,UF:-1,UT:-1,JNT:[-0.0, -90.0, 180.0, 0.001, 90.0, 0.0, 0.0, 0.0, 0.0]};

23.1.2 The main program calls other programs

The main program calls other programs, the syntax is: call the program"program name",

the program executes here, call the subprogram, execute the program content of the

subprogram, after the execution, return to the main program to continue execution (flow

control, details See 2.3 Flow Control Instructions). 【The interface program of the teaching

pendant is as follows】

Main program: adding

statement blocks

JNT: joint
coordinates

6 internal axes + 3

external expansion
axes
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picture 2 1 - 1 Program editing interface

23.2 Program editing

23.2.1 Start editing and exit editing program

The permission to use this function is for engineer users and above.

Note that when editing a program, you need to click the" Start Editing"button before editing

the program. After editing, you need to click the"Exit Editing"button to continue running the

program. Program editing is only possible in teach mode.

Operation steps:

1.Engineers and above users load a program in teach mode.
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2.After loading, enter the program interface. At this time, buttons such as inserting and
changing instructions are gray and inoperable. Click the"Start Editing"button. After clicking,

the buttons such as inserting and changing instructions will become operable, and the
program line can be operated.

3.After the operation is completed, click the"Exit Edit"button, and after clicking, the
buttons such as inserting and changing instructions will turn gray and cannot be operated.
You can directly run the program.

Note: Start editing state cannot uninstall programs and switch modes.
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Figure 23-1 Program editing interface

23.2.2 Insert instructions

The permission to use this function is for engineer users and above.

Explain that inserting instructions can insert welding instructions, motion instructions, process

instructions, etc. into the program. After inserting and exiting editing, the program runs

according to the inserted instructions.

Operation steps:

1. After editing, the buttons of"Joint","Line","Arc","Welding Channel"and"Welding
Command"become operable.

2. Click the"Joint"button to insert a joint motion command in the next row of the
selected row.

3. Click the" Linear"button to insert a linear motion command in the next line of the
selected line.

4. Click the"Arc"button to insert an arc motion command in the next row of the
selected row.

5. Click the"Welding Channel"button to insert a welding channel command in the next
row of the selected row.
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6. Click the"Welding Instruction"button to pop up the first-level instruction selection

box, including motion instructions, process instructions, program control instructions, etc. (as

shown in Figure 23-2). After selecting the first-level menu, the second-level menu of the

instruction will pop up. Click the instruction in the second-level menu to insert the

instruction.

Figure 23-2 Welding command

23.2.3 Change instructions

The permission to use this function is for engineer users and above.

Explain that changing the command can change the inserted command in the program. After
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changing and exiting the editing, the program will run according to the changed command.

Operation steps:

1. After editing, the"Change"button becomes operable. Select the command line that
needs to be changed and click the" Change"button to pop up the command to change the
properties (as shown in Figure 23-3).

2. After the change is completed, click the"OK"button to make the change successful.

3. Click the"Cancel"button to cancel this change.

Figure 23-3 Change command

23.2.4 Remark command

The permission to use this function is for engineer users and above.

The remark command can remark the inserted command in the program. After the remark
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exits editing, the program will not execute the remarked command.

Operation steps:

1. After editing, the" Remark"button becomes operable. Select the command line that

needs to be remarked and click the"Remark"button to remark the instruction. After the

instruction is remarked, it will turn into a gray state (as shown in Figure 23-4).

2. Clicking the"Remark"button again will restore to the unremarked state of the command

after the remark, and the command will become normal.

Figure 23-4 Remark command

23.2.5 Copy and paste instruction properties

The permission to use this function is for engineer users and above.
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Explanation Copying and pasting instruction attributes can paste other motion instruction

attributes to the instruction that needs to change the same attributes.

Operation steps:

1. After editing, the "Copy Attributes" and "Paste Attributes" buttons become

operational, select the command line whose attributes need to be copied, click the"Copy

Attributes"button, and select the attributes to be copied in the pop-up dialog box and

click"OK"button (as shown in Figure 23-5) , including speed, smooth transition, attitude

speed, acceleration, and deceleration.

2. After copying the attributes, select the command line that needs to change the same
attribute and click the"Paste Attribute"button to change the currently selected attribute value.

Figure 23-5 Copy and paste properties

23.2.6 Replacing directive attributes

The permission to use this function is for engineer users and above.
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Description Replacing an instruction attribute can replace the current motion instruction

attribute of the same attribute.

Operation steps:

1. After starting editing, the"Replace"button becomes operable. After clicking

the"Replace"button, a selection input box for replacing attribute selection and replacing a

value with a certain value will pop up. After selecting the attribute, enter the replaced

value and replace Then click the"Up"and"Down"buttons to start replacing the command line

attributes of the currently selected line starting up and down (as shown in Figure 23-6).

2. After clicking the" Replace"button, you can also use the keys to perform attribute
replacement up and down.

3. Click the"Cancel"button to cancel the replacement function.

Figure 23-6 Replacing properties
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23.2.7 Delete instruction

The permission to use this function is for engineer users and above.

Description The delete command can delete any command in the current command line.

Operation steps:

1. After starting to edit, the "More"button becomes operable. After clicking

the"More"button, a more command operation box will pop up. Select the command line to

be deleted, and click"Delete"in the more box to delete the current command. line (as shown

in Figure 23-7).

Figure 23-6 Delete instruction

23.2.8 Copy and paste instructions

The permission to use this function is for engineer users and above.

Description Copy and paste instructions can select existing instructions and copy them to
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other lines.

Operation steps:

1. After starting to edit, the "More"button becomes operable. After clicking

the"More"button, a more command operation box will pop up. Select the command line to

be copied, and click"Copy"in the more box to copy the current command line. After

copying, select the program line to be pasted, and click" Paste"in the more box to insert the

copied command (as shown in Figure 23-8).

Figure 23-8 Copy and paste instructions

23.2.9 Cancelling an order

The permission to use this function is for engineer users and above.

Explain that the undo command can undo a previous operation of inserting, deleting, copying

and pasting, remarking, and changing the attribute of the command line.
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Operation steps:

1. After you start editing, the"More"button becomes operable. After clicking

the"More"button, a more command operation box will pop up. Clicking" Undo"in the

more box will undo the previous insertion, deletion, copy and paste., remarks, and change

command line attribute operations (as shown in Figure 23-9) .

Figure 23-9 Undo command

23.2.10 Continuous selection and single selection instructions

The permission to use this function is for engineer users and above.

Note" Continuous selection"and" Single selection"can select multiple command lines and

operate commands in batches.

Operation steps:

1. After starting to edit, the "More"button becomes operable. After clicking

the"More"button, a more command operation box will pop up. In the more box, click
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"Continuous selection"and" Single selection"to select multiple commands. After multiple

selections, you can change the properties of multiple selections, copy and paste them (as

shown in Figure 23-10).

Figure 23-10 Continuous selection and single selection commands

23.2.11 Instruction description

The permission to use this function is for engineer users and above.

Description An instruction description can describe the purpose or program logic of the

current instruction.

Operation steps:

1. After starting to edit, the "More"button becomes operable. After clicking

the"More"button, a more function operation box will pop up. After selecting an

instruction, click"Description"in the more box to pop up a description dialog box. Enter the

description of the command in the box and click the"OK"button to add the description of the

command (as shown in Figure 23-11).
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Figure 23-11 Instruction Description

23.2.12 Motion to point function

This function can be operated by all users.

Explain that the move to point function can move the robot to the previously recorded point.

Operation steps:

1.After opening the program, select the motion instruction, and then press the"Move to

point"button, the robot will start to move towards the target, and release the" Move to

point"button and the robot will stop moving (as shown in Figure 23-12).

Note: The motion to point function can only be used in teach mode. Press the enable switch

before exercising.
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Figure 23-12 Movement to point

24 Welding programming instructions

24.1 Overview of welding programming instructions

Welding instructions include motion instructions, process instructions, program control

instructions, welding instructions, weaving instructions, etc. Click the"Welding Instruction"button

in the program editing interface to pop up the instruction selection box, as shown in Figure 24-1

below.
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Figure 24-1 Welding instructions

Instruction type and the instruction table included in the type

Instruction type instruction

motion instruction

J
L
A

ACCSPEED

conditional instruction
ELSE
SELECT
CASE
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ELSE,GOTO LBL

Process instruction

CALL
GOTO
LBL
IF

recurssion instruction

FOR
END FOR
WHILE

END WHILE
BREAK

Program control instructions

DO
WAIT
STOP
End
THROW

SET_TOOL
SET_FRAME

Other instructions
SET_TR

run program
PRINT
F

Welding instructions

ARC_CHANNEL
ARC_ON
ARC_OFF

Flifht arcing parameter
Welding process gradient instruction

Weaving instructions

WAVE_ARC
WL
WC

MOVE_WC

Production order
ARC_PRODUCTNUM

ARC_CLEARPRODUCTNUM

Fish-scale pattern
INTERAITENT_WELD

WM
MOVE_WM

Assignment instruction

UFRAME_NUM
UTOOL_NUM

CNT

J_VEL
J_ACC
J_DEC
L_VEL
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L_ACC
L_DEC
L_VROT
C_VEL
C_ACC
C_DEC
C_VROT
PLATLOAD
COL_DETECT

COL_GUARD_ADJUST
SMOOTH
TURN
TALARN
CR

Manual command Enter instructions manuallys

24.2 Motion commands

Explain that the motion command includes joint motion, linear motion and arc motion.

Motion command edit box:

serial

number

illustrate

1

Select instructions, J, L, C three instructions can be selected.

Whenthe C command is selected, two points will pop up in the

conversation box for recording the position.

2
The name of the newly recorded point. With the cursor at this point,

you can click on the record joint or record Cartesian coordinates.

3 Set running speed

4

For parameter setting, you can add the attribute corresponding to the

deletion point in the parameter setting dialog box. After editing the

parameter, click OK to correspond the parameter to that point.

5 The new recorded point is assigned a joint coordinate value.
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6 Assign this newly recorded point a Cartesian coordinate.

7

Click to open a Modify Coordinates dialog box, and you can manually

modify the coordinate values (you need to record the point

information first, and the modified coordinates correspond to the

coordinate type of the record).

8

The value of the newly added point can be saved by creating a new JR

register or LR register, and the relevant value can be found in the

variable list, which facilitates the use of the point value through the

register in the future.

24.2.1 J commands

Instruction description : The J instruction takes the current position of a single axis or a

certain group of axes (robot group) as the starting point, and moves an axis or a certain group of axes

(robot group) to the target point position. The movement process does not perform trajectory and

attitude control, that is, joint motion.

Command example :

J P[1] VEL=50 ACC=100 DEC=100

J P[2]

Command parameters (optional):

The J command contains a series of optional motion parameters, such as speed, smooth

transition, acceleration ratio,, deceleration ratio, etc. After the property is set, it is only valid for the

current motion. After the end of the motion command line, it will return to the default value. If no

parameter is set, thedefaultvalueofeachparameter isusedformotion, suchas: thedefaultparameter used

by the above joint P[2].
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24.2.2 L command

Instruction description : The L instruction takes the current position of the robot as the

starting point, and controls it to perform [linear motion] in the Cartesian space. It is often used in

occasions that require trajectory control. The control object of this instruction can only be [ robot

group] .

Command example :

L P[1] VEL=50 ACC=100 DEC=100 VROT=50

L P[2]

Command parameters (optional):

The L command contains a series of optional motion parameters, translation speed, smooth

transition, acceleration ratio, deceleration ratio, attitude speed, etc. After the property is set, it is

only valid for the current motion. After the end of the motion command line, it will return to the

default value. If no parameter is set, the default value of each parameter is used for motion.

24.2.3 A command

Instruction description : The three points of the A position of the arc command robot together

form two arcs of the same radius, so that the first two points are an arc of one radius, the last two

points are an arc of another radius, and the two arcs are between the two arcs. Points can be added

and deleted, and the motion attributes of the two arcs can be set to different attributes
Command example :

J P[1] VEL=100

AP[2] VEL=500

AP[3] VEL=500

A P[4]

A P[5]

L P[6]

The above shows that when the first circular motion a command (line 2) is

executed, the robot runs

The moving mode is linear motion, that is, from the current position P [1] of the

robot to the target point P [2], from P [2] circular arc to p [3], from P [3] circular arc to p
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Command parameters (optional):

TheA command contains a series of optionalmotion parameters, such as speed, smooth transition,

acceleration ratio, deceleration ratio, attitude speed, etc. After the property is set, it is only valid for

the current motion. After the end of the motion command line, it will return to the default value. If

no parameter is set, the default value of each parameter is used for motion.

①The points on the arc can be added and deleted.

②You can set differentmotion attributes ( speed, acceleration, smoothness,

tooloffset, etc.) for themiddlepointandendpoint of the arc.

③ Each arc track has a different radius.

Notes on using this command:

1.Since the package acceleration of thewelding arc start command is 600 by default, if the
attitude of the welding circle with a small diameter of φ15mm or below changes too much, it will
cause an abnormal deviation of the running track. At this time, changing the acceleration of the A
command to 100 can avoid this phenomenon.

2.Whenrunning a full-circle trajectorywithattitude changes, after running a circle, the Z-axis
is lifted up and a Cartesian point is recorded, and then the movement mode of the point is switched
from a straight line to a joint, and the operation is started to the command. It will appear that the
J6 axis rotates from +358 degrees to -358 degrees (720 degrees in total). This phenomenon canbe
avoided by re-recording the point as joint coordinates after moving to the point.

24.2.4 ACCSPEEDSPEEDLEVEL command

Instruction description : The speed-up instruction is the instruction to increase the

running speed of the robot.

Command example :

MAC ACCSPEEDSPEEDLEVEL=0,OUT

J P[1]

L P[1]

Command parameters :

Speed-up commands include standard and high-speed options.
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24.2.5 Additional axis motion commands

Instruction Description : Additional axis motion commands are asynchronous axis motion

commands.

Command example :

Refer to 22.4 How to Use Asynchronous Axis Motion Commands.

24.3 Conditional instruction

The SELECT statement compares the value stored in the register selected by the
SELECT with the value after the CASE. If the value is equal, the post-case flow instruction is
executed, and the SELECT statement block is jumped out. The following CASE instruction and
ELSE instruction are no longer executed. If they are not equal, the corresponding
CASE of the row is not executed, and subsequent CASE selection judgments continue until the
entire statement block is completed.

Syntax format:

SELECT <num expression>

CASE<num expression>, (GOTO LBL"[”<unsigned int num>“]”)|(CALL <string name>)

[{CASE<num expression>, (GOTO LBL"[”<unsigned int num>“]”)|(CALL <string name>)}

ELSE, (GOTO LBL"[”<unsigned int num>“]”)|(CALL <string name>)]

示例：

SELECT R[0]

CASE 1, GOTO LBL[1]

CASE 2, GOTO LBL[2]

CASE 1, CALL"RT.PRG" ’This is a repeated CASE, if R[0]=1, then only

Row once before LBL[1]

ELSE, CALL"HS.PRG" ’The ELSE command is optional and can be
written or not

GOTO LBL[4]

LBL[1]

J P[1]

GOTO LBL[4]

LBL[2]

J P[2]

GOTO LBL[4]

LBL[3]
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J P[3]

LBL[4]

Execution logic description:

The above procedures are executed successively from the top down, matching R[0].

When R[0]=1, the program moves to P[1] When R[0]=2, the program moves to point P2. When
R[0] is not equal to 1 or 2, the program executes ELSE

The contents of the instruction part of the subroutine HS.PRG are then sequentially executed.

24.4 Process instructions

24.4.1 CALL program instruction

Instruction description: The calling program instruction is used to call the subprogram and

execute the program content of the subprogram.

Command example :

Example: here are two programs, the main program MAIN.PRG, subroutine

SON.PRG.

‘MAIN.PRG(main program)

J JR[1] VEL=50

J JR[2] VEL=50

CALL SON.PRG ‘Call subroutine

wait time=500

Digital output [1]= off

The above execution process, joint movement to JR[1], JR[2], the execution

of digital output [1]= on, forced to wait 500 milliseconds, digital output [1] = off,

turn off the pulse signal, complete the program execution.

The above means that if DI[1]ON, the program content of the TEST.PRG

subroutine is called, otherwise it is held

Remarks: Program calls support multiple levels of nesting, 10 levels and above.

Operation steps :

1.Select the line above the command line to be inserted.
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2.Select Instruction → Process Instruction → Call Program.

3.Click the Select Subroutine button.

4.Select subroutine, OK.

5.Click the OK button in the operation bar to add the calling program instruction to
complete.

picture 2 4 - 1 call program instruction

24.4.2 LBL[ ] and GOTOLBL [ ] instructions

Instruction description : The jump to process instruction is mainly used to jump the

program to the specified label position (process). To use the jump to flow instruction, the flow

label must be defined in the program, and the jump to flow instruction and the flow instruction

must be in the same program block. The jump to flow instruction is used in combination with the

flow instruction to complete the jump of the program, and it will jump to the line specified by the

flow.

Command example :

LBL[1]

GOTO LBL[1]

LBL[1]

J P[1] VEL=50

J P[2] VEL=50 ‘Circular motion between two

points

GOTO LBL[1]

Remarks: The program can realize circular motion through the GOTO statement

Operation steps :

1. Select the previous line of the command line to be inserted.

2 . Select Command→Process Command→ Process, and enter the label number.
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picture 2 4 - 2 Process Instructions - 1

3. Click the"OK"button in the operation bar to insert the process instruction
successfully.

4. Select the command line to jump to.

5. Select instruction→process instruction→ jump to the process, and enter the label
number in the input box

picture 2 4 - 3 Process Instructions - 2

6. Click the"OK"button in the operation bar to add the jump to the process instruction

successfully.

Use jump to process [], process [] to realize program loop running

24.4.3 if command

If the instruction is used for program condition judgment and logic processing, there are

the following two types.

Conditional

instruction

IF condition = true, GOTO LBL

[tag number]

24.4.3.1 IF ….,GOTO LBL[]

Instruction description: The instruction syntax is if... ., jump to the flow [], when the

IF condition = true, CALL"program
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condition is met, execute the GOTO part of the code block; when the condition is not met, execute

the program block starting from the IF descending sequence in sequence.

Command example :

Application exampe ① : It is realized by IF GOTO statement. movement to point P1, R

[2] = 2, movement to point P2, R [3] = 3, movement to point P3

IF R[1] = 1, GOTO LBL[1]

IF R[1] =2, GOTO LBL[2]

IF R[1] =3, GOTO LBL[3]

GOTO LBL[4]

LBL[1]

J P[1]

GOTO LBL[4]

LBL[2]

J P[2]

GOTO LBL[4]

LBL[3]

J P[3]

LBL[4]

Application example ② : It is realized by IF GOTO statement. After 3 times of loop

program, exit the loop.

R[1] =0

LBL[1]

IF R[1]>3 GOTO LBL[2]

J P[1]

J P[2]

R[1]=R[1]+1

GOTO LBL[1]

LBL[2]
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24.4.3.2 IF…., CALL

Instruction description: The instruction syntax is if.... , call the program, when the

condition is satisfied, execute the subprogram. PRG code content and then execute it in sequence;

when the condition is not true, execute the program content starting from the downline, ignore the

called subprogram program.

Command example :

IF <condition>, CALL Program name.PRG

Example:

IF DI[1] =ON,CALL TEST.PRG

J JR[1] VEL =50

DO[1] =OFF

……….

The above indicates that if the di [1] on condition is met, it will be

called first TEST.PRG The program content of subroutine, after execution,

execute J Jr [1] vel = 50, do [1] = off and the following instructions,

Operation steps :

1. Select the line above the command line that needs to be added

2. Select Instruction → Conditional Instruction → If

3. Click the symbol button above the modification box to quickly add conditions ; click
options, you can add conditions, delete conditions, and modify conditions. When
recording the statement, the list of conditions will be connected in the order of addition.
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picture 2 4 - 4 if command

4.Click the up or down button in the action bar to move the position of the condition up
or down.

5.Click to add a group, a check box will pop up, and you can check the conditional
combination to complete the parentheses.

6.Check the check boxes for the conditions in columns 1 to 3, and then click to complete
the grouping.

7.As shown in the figure below, select the first row, and if you click Ungroup again,
you can restore to the state shown in the figure above.

8.Click the OK button in the operation bar to complete the addition of the IF instruction.

24.5 Loop instructions

24.5.1 FOR... END FOR instruction

The FOR statement needs to define the initial value of a variable, the final value, and the

step value (the BY expression is optional, and the default increment is 1 each time it is not

written). The system will determine whether the value of the loop variable is less than or equal

to the final value, and if it is less than or equal to the loop, the loop will be
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executed, otherwise the loop will exit. FOR and END FOR form a loop block.
Syntax format:

FOR<num expression1> TO<num expression2> [BY <num expression3>] [ <lo
op statements>]

END
FOR
Example:

R[2]=0

FOR R[1]=0 TO 2 BY 1

R[2]=R[2]+1

END FOR

Execution logic description:

The loop body variable R[1] has an initial value of 0, a final value of 3, and a step
value of 1, then each loop is increased by 1. In the first judgment, R[1]=0, not

greater than the final value, the first cycle, R[2] =1; In the second judgment, R[1]=1, not greater

than the final value, the second cycle, R[2] =2; In the third judgment, R[1] =2, not greater

than the final value, the third cycle, R[2] =3; In the fourth judgment, R[1] =3, greater than the

final value,
Exit the loop.

So we judged it four times and cycled it three times. After the program finishes
running, R[1]=3, R[2]=3.

Tip:
If you need to use"loop"logic in the application process, it is recommended to add

WAIT in the loop statement

TIME=50 /100 delay instruction to avoid logical processing exceptions that may occur
because the program is executing too fast Question.

24.5.2 WHILE... ENDWHILE instruction

The WHILE statement determines whether the loop ends based on the conditional
expression. When the condition is true, the loop continues; When the condition is false, exit the
loop. The WHILIE statement and END WHILE form a loop block.

Syntax format:

WHILE <bool expression>

[ <loop statements>]

END WHILE

Example:
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R[1]=0

WHILE R[1]<3

R[1]=R[1]+1

END WHILE

Execution logic description:

For the first judgment, R[1] =0, less than 3, the first loop is performed; In the

second judgment, R[1] = 1, less than 3, the second cycle is performed; For the third

judgment, R[1] =2, less than 3, the third cycle is performed; At the fourth judgment, R[1]

=3, not less than 3, exit the loop. It went through the loop three times.
Tip:

If you need to use"dead-loop"logic in the process of application, it is recommended

to add WAIT TIME=50 /100 delay instruction in the loop statement to avoid possible logic

processing exceptions due to fast execution of the program.

24.5.3 The BREAK command

The BREAK statement is used to exit the FOR or WHILE loop.

Syntax format:

<BREAK
>
Example:
WHILE R[1]=0

.... ’Program content

BREAK ’jump out of the loop
END WHILE

FOR R[1]=0 TO 2 BY 1

.... ’Program content

BREAK ’jump out of the loop
END FOR

24.6 Program control instructions

24.6.1 DO

Instruction description: The digital output instruction is used for the operation of the output

signal and the mapping between IO.

Command example :
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DO [1] = ON ‘Output [1] is set to ON

DO [1] = OFF ‘Output [1] is set to OFF

DO [1] = DO [2] ‘output [2] is assigned to output [1]

DO [1] = DI [2] ‘input [1] is assigned to output [1]

Operation steps :

1. Select the previous line where the digital output command line needs to be added

2. Select Command→IO Command→ Digital Output

3. Enter the IO serial number in the first input box

4. Select the corresponding value or IO in the second selection box. If IO is selected,
you need to enter the corresponding IO serial number in the corresponding input box.

5. Click the"OK"button in the operation bar to complete the addition of the IO
instruction.

24.6.2 WAIT TIME command

Instruction description: The usage scenarios of delay instructions can be divided into two

situations. The first one is used to wait for a certain input state (digital input), output state (digital

output) or whether the value of the R value is equal to the set value. If the condition If it is not

satisfied, the program will block in this line until the condition is satisfied and continue to execute

the following program content; the second is to force the wait for how many milliseconds before

continuing to execute the following program content. The timeout command is the command that

acts on the first case and is used in conjunction with the timeout setting.

J P [1]

WAIT TIME 1000 ‘After moving to P1, wait for 1 second after sleep, DI [1] will output the signal

number

DI [1] = ON

J P [2]

J P [3]

Command example :
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Remarks: When editing a delay instruction, after editing the delay condition, if the

process to be jumped after editing timeout is selected as None, the timeout setting has no effect on

the instruction. If it is blocked in this row, it can only be released by clicking"More → Release

Waiting"in the lower menu bar.

Figure 24-6 Delay Condition Instruction

24.6.3 PAUSE instruction

Instruction description: The suspend instruction is used to suspend program execution.
Command example :

J P [1]

J P [2]

PAUSE ‘the program is executed to this line, the program status is changed to

pause

Remarks: As in the example program above, the program moves to point P1, and then to

point P2. When the program executes the pause command, the program state changes from running

to pause state, and the current actual position is still at point P2.

Operation steps :

1.Select the line above the command line to be inserted.

2 .Select Command→ Program Control Command→ Pause.

3 .Click the OK button in the operation bar to add the PAUSE instruction to complete.

picture 2 4 - 7 Pause instruction

24.6.4 END command

Instruction description: This instruction is used to end the program running.

Command example :

J P [1]

J P [2]

END ‘the program is executed to this line, the program ends, and the

program pointer returns to the first line
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Remarks: As in the above program, the program moves to point P1, and then to point P2.

When the program executes to the end command, the program state changes from running to ready

state, the pointer returns to the first line, and the current actual position is at point P2. Press the run

button, the program moves to point P1, and then to point P2, the program state changes from

running to ready state, and the pointer returns to the first line.

Note: When the subprogram is called in the main program, and the

subprogram contains the end, then the end subprogram continues to

execute the main program program content

Steps

1.Select the line above the command line to be inserted.

2.Select Command→ Program Control Command→ End.

3.Click the OK button in the operation bar to complete the addition of the end command.

picture 2 4 - 8 end command

24.6.5 THROW command

Instruction description: This instruction is used for user-defined part of the alarm and

prompt, the alarm prompts the user or stops the robot program running.

Command example :

J P[1]

J P[2]

THROW：“Logical error"LEVEL=ERROR J

P[3]

Command parameters:

Unrecoverable: Unrecoverable serious errors, the robot stops motion, the motion buffer is

emptied, the program enters an error state and the cache is emptied, and cannot be recovered (the

program cannot be resumed).

Alarm recoverable: recoverable error, the robot stops motion, the program enters an error

state, but the motion buffer is not emptied, and the operation can be resumed.
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Warning: The system is in a critical state or the user's operation may lead to adverse

consequences and other prompts, which will not cause the program or motion to stop.

Hint: A general hint message for user guidance.

Information: General system status information or user operation records that are not

prompted by the user.

Operation steps :

1. Select the previous line of the command line to be inserted.

2. Select Command→ Program Control Command→ THROW .

3. Enter custom alarm information in the"Alarm Information Input Box".

4. Click the"Alarm Type"drop-down box option and select it.

5. Click the OK button in the operation bar to complete the adding alarm information
instruction.

24.6.6 SET_TOOL command

Instruction description: This instruction can assign and modify the value of the tool

coordinate system through the program.

Command example :

LR[0]= UT[0] ‘Assign the coordinate value of tool No. 0 to LR [0]

UTOOL_NUM = 0

SET_TOOL 0 LR[0]

Operation steps :

1. Select the previous line of the command line to be inserted.

2. Select command→ program control command → SET_TOOL.

3. Enter the tool number in the"Set tool number input box".

4. Click the"LR"input box again and enter the LR index number.

5. Click the OK button in the operation bar to complete the command to add the setting
tool number.

24.6.7 SET_FRAME command

Instruction description: This instruction can assign and modify the workpiece coordinate

system value through the program.
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LR[1]= UF0 ‘Assigns the coordinate value of the job number 0

toLR[1]

FRAME_NUM = 0

Command example :

Operation steps :

1. Select the previous line of the command line to be inserted.

2. Select command→ program control command → SET_FRAME.

3. Enter the workpiece number in the"Set workpiece number input box".

4. Click the"LR"input box again and enter the LR index number.

5. Click the OK button in the operation bar to complete the instruction of adding and
setting the workpiece number.

24.7 Other commands

24.7.1 The SET_TR command

The process of the robot arm to complete a motion track is: static (starting point) -

acceleration - uniform speed - deceleration - stop (target point), and the speed is not uniform in the

acceleration and deceleration section. If the manipulator reaches the starting point or target point

and then outputs the signal or turns off the signal, it will introduce a track segment with uneven

speed, which will cause uneven gluing in gluing or welding applications and reduce the processing

quality of the product. Use SET_TR and BIND_TR

Signal trigger, which can turn the signal on or off in a specified track segment position.

Syntax format:

SET_TR[num], DS|DE|DC=<num>, <signal expression>

<Motion Type><Target Point>, BIND_TR[num1,num2...]

Parameter description:

Starting point: Normally the target point of the previous motion instruction.

When the motion terminates, the current position of the robot should be used as the starting
point for re-calculation after restarting the motion.

DS: Short for DISTANCE START, the distance from the starting point of the
robot motion.

DE: Short for DISTANCE END, the distance from the moving target point.

DC: Short for DISTANCE COMPLETE, referring to the percentage of distance
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completed

triggering
condition

DS=xx DE=xx DC=xx

meaning Robot TCP

outputs signals

when the distance

from the starting

point of robot

operation exceeds
xx mm

When the distance

between the robot
TCP and the target
point of the robot
operation is within
xx mm, the signal is
output

Robot TCP has run
this line of motion
instruction robot
TCP needs to move
the whole distance
length xx%, the
output signal

triggering
condition

The robot

leaves the starting

point, and the

distance

(instruction)

between the robot

and the starting

point is greater than
xx mm

The robot is

moving towards the
target point, and the
distance

(instruction)

between the robot

and the target point is
less than xx mm

The robot

moves towards the

target point, and the
percentage of the
TCP distance

traveled by the

robot in the length of
the whole path is
greater than xx

output signal When the robot meets the trigger conditions, the signal is
output or turned off

example：
SET_TR[0], DS=50, DO[4]=ON

SET_TR[1], DE= 100, DO[4]=OFF ’Set the trigger number to 1 and specify the end point target
100mm distance output DO[4]=OFF

J P[0]

L P[1], BIND_TR[0]
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L P[2], BIND_TR[1] ’P2 Point set trigger 0 or 1, can be set single or multiple devices, with
Comma separated
Execution logic description:

In the example program, the first 2 lines of the program set trigger 0 and 1, that
is, DO[5] output ON at the end point 100mm (note: when there is the same

trigger number, execute with the latest trigger number condition) binds trigger 0 at point P1
and trigger 1 at point P2; The robotic arm moves in a straight line to P[1], and then from P[1]
to P[2]. The system will periodically detect the position of the

robot TCP distance points P1 and P2. When the distance P[1] is greater than 50mm, DO[4]
=ON signal output; When the distance P[2] is less than 100mm, DO[4] =OFF.

Tip:

(1) When the robot starts to move and has met the trigger conditions, the
corresponding signal will be output when the robot starts to move.

(2) When there is CNT smoothing, the smooth transition does not pass the target
point, and the distance from the target point may not meet the trigger conditions, so no signal
output is performed.

(3) When the program line is paused midway and then resumed, the trigger
condition will be judged again from the current robot position.

(4) The specified distance signal output J joint command is invalid.

(5) In the actual operation process, the specified distance signal output is
related to the running speed of the robot arm, and the signal output point will have a slight
error, which can be adjusted by lowering the output point speed or adjusting the

specified distance value.

24.7.2 PRINTF instructions

This command can print display information directly in the information display bar of the
instructor. Use semicolons to separate multiple printed messages.
Syntax format:

PRINTF <string> <string|double> {;<string> [string|double]}

example：
SR[1]=“tom”

SR[2]=“jerry"

R[1]=10

R[2]=20

PRINTF"Height:"R[1];"Thickness:"R[2] ’Height :10; Thickness :20
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PRINTF SR[1]

PRINTF SR[1] SR[2] ’ Syntax error, missing data item

24.8 Welding instructions

24.8.1 Welding Instruction

Instruction description: Set the welding channel data, which is generally used to call

multiple sets of process parameters for one welding seam.

Command example :

J P[0]

L P[1]

ARC_ON(1)

L P[2]

ARC_CHANNEL(1)

L P[3]

ARC_OFF(1)

Operation steps :

1. Select the previous line of the command line to be inserted.

2. Select command→ welding command → Welding Instruction.

3. Select the channel number for calling welding data in the drop-down box.

4. Click the OK button in the operation bar to complete the adding welding channel
command.

Remarks: Inserting welding channel command can also directly click the"Welding

Channel"button in the program editing interface.

24.8.2 ARC_ON command

Instruction description: Set welding data and start welding.

Command example :

J P[0]

L P[1]

ARC_ON(1)

L P[2]

ARC_OFF(1)
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Operation steps :

1. Select the previous line of the command line to be inserted.

2. Select command→ welding command → ARC_ON.

3. Select the channel number for calling welding data in the drop-down box.

4. Click the OK button in the operation bar to complete the addition of the arc start
command.

Remarks: The arc start command and the arc end command should be used in pairs and

placed before the arc end command.

24.8.3 ARC_OFFcommand

Instruction description: End welding.

Command example :

J P[0]

L P[1]

ARC_ON(1)

L P[2]

ARC_OFF(1)

Operation steps :

1. Select the previous line of the command line to be inserted.

2. Select Command→ Welding Command → ARC_OFF.

3. Select the same channel number as the most recent arc strike command in the

drop-down box.

4. Click the OK button in the operation bar to complete the addition of the arc ending

command.

Remark: The arc ending command and the arc starting command should be used in pairs and

placed after the arc starting command.

24.8.4 FLIGHT command

Instruction description: Start arcing ahead of time after the distance set from the arcing

point. Flying arcing can increase the production takt by increasing the time used for arcing.

Command example :
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MAC FLIGHT DISTANCE =0,OUT

J P[0]

L P[1] BIND_TR[1]
ARC_ON(1)

L P[2]

Operation steps :

1. Select the previous line of the command line to be inserted.

2. Select command→ welding command →FLIGHT.

3. In the input box, enter the distance from the arc starting point that needs to be started
in advance.

4. Click the OK button in the operation bar to add the flight arc start parameter setting
command to complete.

5. After adding the flight arcing parameter setting command, at the point where the
flight arcing is required, click to change the properties, check the flight arcing check box, and
click the OK button, the point becomes the flight arcing point.

Example of flight arc execution :

Take a common welding machine as an example: if the default slow wire feeding speed is

50mm/s for arc starting, the distance from the end of the welding wire to the workpiece after arc

ending is about 10 mm, and normally there is no flying arc starting function, and the welding wire

needs 200ms in the arc starting stage to When the robot touches the workpiece for ignition welding,

since the robot is a deceleration process when it reaches the welding arc starting point, there is

no fixed running speed, so the actual distance of the robot running 200ms before the arc starting

point cannot be accurately calculated. Adjust after the situation is preset. Generally, the test

distance is set as the distance from the tip of the contact tip to the workpiece. As shown in the

RAC_OFF(1)
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figure above, first set 10mm in the flight arc starting parameter setting command, then perform

welding, and then adjust the parameters according to the actual production situation.

Remarks: Since the flying arc starting function is to execute the arc starting action before the

robot reaches the actual arc starting point, in actual use, it is necessary to avoid the arc blasting

and arc drawing affecting the rhythm caused by the robot arcing and feeding too long.
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24.8.5 Welding instruction sample program

24.8.5.1 Application method for one weld joint with only one group of process

parameters

J P[0]

JP [0]

L P[1] ‘Arching point

ARC_ON(1) ‘Directive for arc striking which will invoke welding
channel (1) by default

L P[2] ‘End weld (extinguish point)

ARC_OFF(1) ‘Directive for arc withdrawal

L P[3] ‘Transition point

Remark: ARC_ON will invoke parameters of a welding channel to perform welding.

Please confirm the accuracy of the parameters of the welding channel before operation!

24.8.5.2 Application method of one weld joint with multiple groups of process

parameters

L P[1] ‘Arching point

ARC_ON(1) ‘Directive for arc striking which will invoke welding

channel (1) by default

L P[2] ‘End weld of the first section

ARC_CHANNEL(2) ‘Invoke a channel

L P[3] ‘End weld of the second section

ARC_CHANNEL(3) ‘Invoke a channel

L P[4] ‘End weld of the third section, extinguish point
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ARC_OFF(1) ‘Directive for arc withdrawal

L P[5] ‘Transition point

ARC_CHANNEL and ARC_OFF may be modified after insertion as Figure 12. 16 displays.

After selecting the directive line to be modified, a button says modify will show up.
Click modify, there will come a dialog box as illustrated in Figure 24-10.

Figure 24-10 Modify the channel
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Figure24-10Asshown,youcanselect thechannel number to bemodified, select the process parameters,
and the current, voltage, welding speed modification box will pop up. After setting the voltage, current,
and welding speed, the welding voltage, welding current, and welding speed are subject to the
current

settings. The voltage, current and welding speed in the welding channel shall prevail.After selecting,
click OK to complete the modification of the channel number, voltage, current and welding speed.
The arc detection function is added to the arc starting command for fish scale welding.

Figure 24-11 Modify the channel number that is voltage and current

Figure 24-11, you can select the channel number to be modified, and select the voltage and

current to pop up the voltage and current modification boxes. When the voltage and current are set,
the welding voltage and welding current are subject to the current settings. The voltage and current

in the list shall prevail. After selecting, click OK to complete the modification of the channel

number, voltage and current.



Welding Process System Instruction Manual

236

24.9 Swing command

The swing welding function means that when the robot arm executes a straight line or arc

trajectory, it moves in the specified direction and superimposes a motion to realize that the motion

trajectory of the final end TCP is the trajectory of the specified shape. Swing welding motion is

commonly used in welding and grinding applications, the common swing trajectory are sine Z-

shaped pendulum, circular pendulum, crescent pendulum, 8-shaped pendulum, L-shaped

pendulum.
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24.9.1 Call pendulum welding channel parameter setting description

图24-12 Swing welding channel modification

The parameters are defined as follows：

Wobble trajectory type ：Determine the type of trajectory, if the linear pendulum welding,

directly select the straight line can be; If there is a circular pendulum welding, choose arc; If it is a

straight line + arc, directly select"Straight line"。

Oscillating shape ：Optional Z-shape, circle, L shape, positive crescent, reverse crescent,

figure 8。

Amplitude of swing ：That is, the distance between the wave crest and the central axis, in

millimeters。

Swing frequency：That is, how many swing tracks are taken in 1 second, unit: Hz。
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Oscillating plane：The plane in which the swing is located, that is, the direction of the swing

motion. Taking the line between the starting point and the target point as the X-axis, the first plane

is established on the z-axis of the tool coordinate system, and then the Y-axis of the oscillating

plane is obtained by the cross product of the normal vector of the first plane and the X-axis, and

then the Z axis of the oscillating plane is obtained by the cross product of the X and y-axes. The

XYZ axis establishes the oscillating coordinate system. 0: along the oscillating coordinate system

Y axis; 1: Along the Z axis of the oscillating coordinate system; 2: Along the X-axis of the

oscillating coordinate system.

Stay or not：The options are Yes and No.

Left residence time ：Left endpoint residence time. In seconds, rounded by 4ms if not an

integral multiple of the interpolation period. The rounding principle.

Right residence time：Right endpoint residence time. In seconds, rounded by 4ms if not an

integral multiple of the interpolation period. The rounding principle.

Elevation：That is, the Angle of rotation about the X-axis of the oscillating coordinate system,

in degrees, with a value range of +-90 degrees. When the value is positive, it rotates

counterclockwise, and when the value is negative, it rotates clockwise.

Azimuth Angle：Tilt of the welding track on the specified swing plane, the value is positive,

and the left end point is inclined to the X+ axis; When the value is negative, the right endpoint tilts

towards the X+ axis. The unit is degree. The value ranges from + to 90 degrees. When the value of

ORI is equal to +-90 degrees, the direction of swing is parallel to the X-axis.

Reference point one：LR index value of the register, 0 to 999. The point on the first face of

the L-swing is saved in the LR register.

Reference point two：LR index value of the register, 0 to 999. The point on the second face of

the L-swing is saved in the LR register.

24.9.2 Pendulum welding type description

24.9.2.1 z-swing

The trajectory of the sine Z-wave swing is as follows. The manipulator can swing up and

down on the specified swing plane when executing a straight line or arc trajectory.
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24.9.2.2 Circular swing

The circular swing trajectory is as follows: When the robot arm performs a straight line or arc

trajectory, it can draw a circle and move forward on the specified swing plane.

24.9.2.3 L-swing

There is an Angle between the two plates, and the robot arm alternates swinging action on the

two plates while performing the main motion. The L-shaped swing trajectory is as follows.
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Note: When using L-swing, in addition to teaching the straight track, it is also necessary to

teach the" reference point one"and" reference point two"on the surface of the two plates. In the

index of the LR register specified by the swing welding channel number parameter, the two points

shown are used to determine the Angle between the plate and the weld track. L-pendulum cannot

be used for arc trajectories.

24.9.2.4 Positive crescent swing

The orbit of the positive crescent is as follows:

24.9.2.5 Countercrescent swing

The inverse crescent wobble trajectory is as follows:
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24.9.2.6 Figure of eight swing

The 8-figure swing trajectory is as follows: When the robot arm executes the straight line or

arc command, it can move forward while depicting the 8-figure on the specified swing plane. As

shown below:

24.9.3 Example call swing welding channel instruction

Instruction specification：

Set the swing welding parameters for the swing welding procedure.
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Example instruction:

J P[0]

LP[1] ‘起弧点

MAC WEAVESTART
ARCINGWELDCHANNELINDEX= 1,OUT ‘摆动开始指令

arcing(1)

L P[2]

L P[3]
A P[4]
A P[5]

A P[6]

LP[7] ‘收狐点

Arc Off(1)

MAC WEAVEEND
ARCINGWELDCHANNELINDEX= 1,OUT ‘摆动结束指令

J P[8]

Operation procedure：

1. Open the welding process package → process parameters → swing welding channel,
select channel 1, click"Modify"button, and set the required swing welding parameters.

2. Create a new program, click the"Open"button, click the"Program Edit"button.

3. Move the robot to the specified position and select insert joint, line, arc command.

4. Select instruction → Swing welding instruction → Call swing welding channel instruction.

5. Click the OK button in the operation bar to add and call the swing welding channel
instruction.

Program example：
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图 24-13 Example of standard procedure for pendulum welding

24.10 Production statistics instruction

24.10.1 ARC_PRODUCTNUM Instructions

Instruction description: This instruction is a statistical output command, which counts the

output of welding workpieces.

Command example :

J P[0]

L P[1]

MAC ARC_PRODUCTNUM(1),OUT

Operation steps :

1. Select the previous line of the command line to be inserted.
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2. Select Command→ Production Command → ARC_PRODUCTNUM.

3. Select the output statistics channel number to be used in the drop-down box.

4. Click the OK button in the operation bar to complete the addition of the output
statistics command.

Note: After the output statistics command is executed, you can view it in Process Package

→ Production Statistics.

24.10.2 ARC_CLEARPRODUCTNUM command

Instruction description: This instruction clears the output of the corresponding channel.

Command example :

J P[0]

L P[1]

MAC ARC_CLEARPRODUCTNUM(1),OUT

Operation steps :

1. Select the previous line of the command line to be inserted.

2. Select command → output command → ARC_CLEARPRODUCTNUM.

3. Select the channel number to be cleared in the drop-down box.

4. Click the OK button in the operation bar to add the output reset command to complete.

24.11 Fish scale command

24.11.1 NTERMITTENT_WELD command

Instruction description: This instruction is a motion instruction, and the welding effect is

fish scale after execution.

Command example :

J P[0]

ARC_ON（1）

MAC INTERMITTENT_WELD P[1] VEL=8mm/s Time=80ms Interval

distance=1mm

ARC_OFF（1）

Operation steps :

1. Select the previous line of the command line to be inserted.
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2. Select Command→ Fishscale Welding Command → NTERMITTENT_WELD.

3. In the input box, you can input the translation speed, time and interval distance.

4. After the input is completed, click the OK button in the operation bar to complete the
addition of the linear fish scale welding instruction.

24.11.2 SA command

Instruction description: This instruction is the record of arc fish scale welding point, which

records the arc position of arc fish scale welding.

Command example :

J P[0]

ARC_ON(1)

MAC SAP[1],OUT

MAC SAP[1],OUT

MAC SAP[1],OUT

MAC MOVE_SA,OUT

ARC_OFF（1）

Operation steps :

1. Select the previous line of the command line to be inserted.

2. Select Command → Fish Scale Welding Command → SA.

3. Click the OK button in the operation bar to add the arc fish scale welding point
recording command to complete.

Remarks: More than 3 arc fish scale welding point recording instructions need to be inserted

together, otherwise the arc path cannot be planned.

24.11.3 MOVE_SA command

Instruction description: This instruction is the motion instruction of arc fish scale welding,

which is generally placed under the arc fish scale welding point recording instruction.

Command example :

J P[0]

ARC_ON(1)

MAC SAP[1],OUT

MAC SAP[1],OUT

MAC SAP[1],OUT

MAC MOVE_SA,OUT

ARC_OFF（1）
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Operation steps :

1. Select the previous line of the command line to be inserted.

2. Select the command → fish scale welding command → MOVE_SA.

3. In the input box, you can input the translation speed, time and interval distance of the
movement.

4. Click the OK button in the operation bar to add the arc fish scale welding motion
command to complete.

24.11.4 Example program of fish scale instruction

24.11.4.1 Use of linear fish scale welding instructions

J P[0] ‘Normal editing program

MAC ARC_ON（1）

MAC INTERMITTENT_WELD P[1] VEL=8mm/s Time=100ms Interval

distance=1mm

MACINTERMITTENT_WELD P[1] VEL=8mm/s Time=150ms Interval distance=1mm

MAC INTERMITTENT_WELD P[1] VEL=8mm/s Time=80ms Interval distance=1mm

MAC ARC_OFF（1）

J P[4]

Figure 24-14, when there is a fish scale welding instruction in the program, the weld
effect is similar to"fish scale".

24.11.4.2 Use of arc fish scale welding instruction

J P[0] ‘Transition point

MAC ARC_ON(1) ‘Arc striking command, calling a set of welding
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channel data

MAC SA P[1] ‘Record high-precision arc point instruction

MAC SA P[2] ‘Record high-precision arc point instruction

MAC SA P[3] ‘Record high-precision arc point instruction

MAC MOVE_SA ‘Execute high-precision circular motion command

MAC ARC_OFF（1） ‘Arc stop command

J P[4] ‘Transition point

shown in Figure 24-15, the use of arc fish scale welding instruction.

24.12 Assignment Instructions

Instruction description: The assignment instruction is divided into three parts : register

operation, coordinate system call, and global parameters.
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Assignment
instruction

Motion-global variables
CNT = 100
L_VEL = 50
L_ACC = 50
L_DEC = 50
L_VROT = 50

J. ..

C. .. wait

24.12.1 Register Instructions

Instruction description:AUCTECH III system pre-defined several groups of different types

of registers for users to use. It includes floating - point R registers, joint coordinate type JR

registers, and Cartesian type LR registers. There are 300 R registers available for users to use, and

300 JR and LR registers . In general, the user assigns the preset value to the register corresponding

to the index number, such as: R[ 0 ] = 1, JR[ 0 ] =JR[1], LR[ 0 ] =LR[1], the register can be

directly used in the program. Register instructions include R[] , JR[] , LR[] , JR[][], LR[][], P[],

P[][].

Command example :

register
R [1] = 0
JR [1] = JR [0]
LR [1] = LR [0]
JR [1] = P [1]
JR [1] [0] = JR [1] [1]

LR [1] [R [1]] = R

[2]. .. wait

Send coordinate system
UTOOL_NUM = 0

UFRAME_NUM = 0
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Operation steps :

1.Select the line above the line where the register instruction line needs to be added.

2 .select instruction → assignment instruction

3.In the first input box, the"Register"drop -down box selects the register type

4.Enter the register index number in the input box

5.Repeat steps 3 ~4 in the second input box.

6.Click the"OK"button in the operation bar to complete the addition of the assignment-
register instruction.
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Then JR [0] [1] refers to the

second axis of the JR register index

[0], which is 90

假设JR[0]={0,-90,180,0,90,0}

Remarks : The JR\LR register supports obtaining the current robot position to the position

register andmodifying the value of thecurrent position register during the program editing process. The

specific operation method is as follows (take the motion instruction J JR[0] as an example), select the

motion instruction J JR [0], click"record joint"to open the JR[0] register editing interface. After

modifying the coordinate value, click"OK"to save the currently modified coordinate value to the

JR[0] register. It should be noted that when the JR register is used in the motion instruction, only the

joint position can be recorded, and when the LR register is used in the motion instruction, only the

Cartesian position can be recorded.

24.12.2 Coordinate system command

Instruction description: This instruction is used to call the tool and the workpiece number

in the program (Note : the point is recorded in the program, if the tool workpiece is used, the tool

workpiece coordinate system needs to be added to the program) The coordinate system command is

divided into the base coordinate system workpiece coordinate and Tool coordinate system, the

defined coordinate system number can be selected in the program, and the coordinate system can

be switched in the program. The tool and workpiece numbers are 0~15 , and the default coordinate

system is -1.

Command example :

Remarks:Thecallabletoolworkpiecenumber is0~15, -1 isthedefaultcoordinate system

Note: If the point recorded by the tool orworkpiece is called, the corresponding coordinate system

must be added to the program to instruct the trajectorymovement to be correct.



Welding Process System Instruction Manual

251

24.12.3 Global variable directive

Instruction description: The global variable instruction is used to define the global

parameters of the program, and it takes effect in the entire program, except for

those with parameters.

The difference between global parameters and local parameters is as follows:

LBL[888]

LBL [888]
J P[1]

J P[2] ‘Is the default motion

parameter
J P[3]
J P[4]
GOTO LBL[888]

J P[4]

GOTO LBL[888]

LBL[888]

CNT =1
J_VEL = 100

J_ACC = 100

J_DEC = 100 ‘Global motion parameters, function downwards, P [1, 3] use the above motion parameters J
P [1]
J P [2] VEL = 50 ACC = 50 DEC = 50 CNT = 0 ‘P [2] uses its own motion parameters

J P [3] VEL = 50 ‘P [3] uses its own VEL parameter. Since other parameters are not set, it still uses the global
ACC and DEC above.

GOTO LBL [888]

Operation steps :

1. Select the previous line of the register instruction line to be added.

2 . Select instruction→assign instruction

3. In the first input box, select the type from the"Global variable"drop -down box

4. Enter a value in the second input box

5. Click the"OK"button in the operation bar to complete the assignment-adding of the
global variable instruction.

The motion parameters are as follows:

The global parameter instruction is used to define the global parameters of the program, which

takes effect in the whole program, except for the parameters with its own.

CNT =1

J_VEL = 100

J_ACC = 100

J_DEC = 100‘Global motion parameters, function downwards,

P [1 ~ 4] use the above motion parameters
J P[1]

J P[2]

J P[3]
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For usage, please refer to the [Motion Parameters] section.

CNT = 0 ~ 100 ‘Smooth transition to 0, default is not smooth
CNT_TYPE = 0/ 1/2/ 17 ‘Smooth Type
J_VEL = 1 ~ 100 ‘joint speed
J_ACC = 1 ~ 100 ‘joint acceleration ratio
J_DEC = 1 ~ 100 ‘joint reduction ratio
L_VEL = 1 ~ 1000 ‘Linear speed
L_ACC = 1 ~ 100 ‘Linear acceleration ratio
L_DEC = 1 ~ 100 ‘Linear reduction ratio
L_VROT = 1 ~ 100 ‘Linear attitude speed
C_VEL = 1 ~ 1000 ‘arc speed
C_DEC = 1 ~ 100 ‘arc reduction ratio
C_ACC = 1 ~ 100 ‘arc acceleration ratio
C_VROT = 1 ~ 00 ‘arc attitude speed

24.12.4 Arc transition smoothness

Instruction description : The smoothness mode can be used in the mixed motion of joint

interpolation and Cartesian interpolation. This parameter defines the starting position of the arc

transition, and its value is a percentage.

path is A->B->C, and the arc transition function is used at point B, then the blending

coefficient value defines the position of the starting point D of the arc transition : AD= blending

coefficient * AB/100

When this parameter is set to 100, it means that the arc transition starts from point A and

ends at point C, and the whole new path is completely different from the original path. but the

parameter is set to 0, it means that the arc transition function is not used.

Sample program :
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Special instructions: as shown in the figure

【 Signal output and smooth transition point 】 [WAIT waiting condition and

smooth transition ]

L P[1]

L P[2] CNT=50

WAIT DO[1] = ON ‘At this point, the signal is

output at the transition point DJ P [3] ‘Note: If the

WAIT condition is not met, it will stop at The P [2]

point wait condition is satisfied, and there is no

smooth action at this time.turning point can be

24.12.5 Distance Smoothing Parameters

In gluing, grinding and other trajectory
tracks has geometric characteristics, requiring t

L P[1]

L P[2] CNT=50

DO[1] = ON‘At this point, the signal is output

at the transition point D

J P[3]

specified, in this case, the user can use the CR attribute function, CR attribute specifies the

distance between the turning point and the target point during the smooth transition, the value is
positive, the unit is millimeter (mm). The larger the value, the larger the radius of
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the corner, and the farther the turning point of the smooth trajectory is from the target point.
Syntax format:

<Motion Type><Tatget Point>[CR=<num expression>]

example：

L P[1]

L P[2] CR=20

L P[3]

Tip:

(1) CR is a positive number, that is, the value is greater than 0, and
the input is incorrect.

(2) When the CR value is less than half of the short side, the
radius value of the actual corner path is the arc of CR.

(3) When the value of CR is greater than half of the short side, the
actual corner radius is equal to half of the short side, but

because it is speed smooth, in the case of long line segment to

short line segment, the actual turning point may change according to the
different speed values, so that the smooth trajectory also has a
corresponding change.

(4) The CR attribute supports the L instruction, does not

support the JUMP instruction, and does not alarm when written, but will
have no effect.

(5) In the case of two-point reentry motion, or three-point

collinear, the trajectory characteristics will cause the value of CR to
have no effect, and the motion will be accurate to the point.

(6) CR and CNT attributes can be used when velocity

smoothing CNT_TYPE= 1, or trajectory smoothing CNT_TYPE=2.
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CNT_TPYE specifies the smoothness type, while CR and CNT specify
the smoothness value.

24.13 Teaching Instructions

Instruction description: used to teach the input command line.

picture 21 - 13 Teaching Instructions
Operation steps :

1. Select the previous line where the teaching instruction needs to be inserted.

2. Enter the command.

3. Click the OK button in the operation bar to complete the addition of the command.
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